
Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard 

The Chart Data Grid

Changing the Chart Type 

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Introduction 

Getting Technical Support 

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

Chart Terminology 

General Chart Elements 

2D Chart Elements 

3D Chart Elements 

Selecting Chart Elements 

Formatting Chart Elements 

Double Clicking on Chart Elements 

Using Dialog Boxes 

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Wizard 

Navigating in the Chart Wizard 

The Gallery Tab 

The Style Tab 

The Layout Tab 

The Axes Tab 

Modifying Charts with the Wizard 

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Chart Data Grid 

The DataGrid Editor 

Resizing the Data Grid 

Modifying Data in the Data Grid 

Adding Row and Column Labels 

Modifying Row and Column Labels 

The Menu Bar 

Inserting a Data Grid Row 

Inserting a Data Grid Column 

Deleting a Data Grid Row 

Deleting a Data Grid Column 

Inserting a Column of Data Grid Row Labels 

Inserting a Row of Data Grid Column Labels  

Deleting a Column of Data Grid Row Labels 

Deleting a Row of Data Grid Column Labels  

Area Charts 

Bar Charts 

Horizontal Bars 

Clustered Bars 

Line Charts 

Step Charts 

Combination Charts 

Pie and Doughnut Charts 

Radar Charts 

XY Charts 

Polar Charts 

Bubble Charts 

Hi-Lo Charts 

Gantt Charts 

Elevation Charts: Surface and Contour 

3D XYZ Charts 

3D Scatter Charts 



Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

The Format Plot Dialog 

Selecting a Chart Type 

Stacking on a Percent Axis  

DataPoints As Lines or Markers 

Using Combination Charts 

Using Radar Charts 

Using Hi-Lo Charts 

Specifying Volume Information for Hi-Lo Charts 

Displaying Hi-Lo Bars In Other Chart Types 

Reordering Series 

How Reordering Series Affects the Chart. 

Stacking Series 

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Adding Chart Elements 

Controlling the Display of Chart Elements 

Automatic Chart Layout 

Chart Element Areas 

Positioning Chart Elements 

Repositioning Chart Elements 

Custom Chart Element Positions 

Effect of Element Positioning on the Chart 

Optimizing Chart Text 

Formatting Fonts 

Aligning and Orienting Text 

Assigning Backdrops to Elements 

Editing Backdrops 

Backdrop Fills 

Picture Fit Methods 

Resetting To Default Formats 

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 



Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting 3D Charts 

Changing Chart Rotation and Elevation 

Chart Elevation Options 

Chart Rotation Options 

Chart Projection 

Chart Width and Height Ratios 

Chart Viewing Distance 

Formatting the Base and Walls 

Lighting 3D Charts 

Ambient Lighting 

Infinite Light Sources 

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Formatting Axes 

Axis Terminology 

Common Axis Elements 

Gantt and Horizontal Bar Charts 

Radar and Polar Charts 

How to Format an Axis 

Labeling Axis Tick Marks 

Labeling Axes Inside The Plot 

Displaying Axes Scales 

Automatic and Manual Scaling 

3D Axis Intersections 

Date Axis Scaling 

Radar Axis Scaling 

Polar Axis Scaling 

Formatting Axis Ticks 

Formatting Axis Labels 

Format Axis Labels Dialog 

Controlling Label Position 

Standing Labels 

Axis Label Text Formatting 

Axis Titles 

Plot Options

Formatting Series and Data Points



Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Plot Options 

Controlling Bar Spacing 

Controlling Chart Direction 

Starting Angle Rotation 

Chart Layout Options 

Pie and Doughnut Chart Options 

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Series and Data Points 

Supplying Series Data 

Formatting Series Data 

Setting Series Options 

Bar Shapes 

Smoothing Series Data 

Hi-Lo-Close Colors 

Changing the Series Fill and Pen 

Picture Bars 

Formatting Lines 

Formatting Markers 

Formatting Statistics Lines 

Formatting Guidelines 

Formatting Data Points 

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts



Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Formatting Labels 

Series Labels 

Series Label Options 

Data Point Labels 

The Format Data Point Label Dialog 

Label Options 

Controlling Label Type 

Formatting Label Text 

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Elevation Charts 

The Elevation Tab 

Displaying Contours 

Displaying Chart Bases 

Surface Chart Projection 

Displaying Chart Surfaces 

Displaying Wireframe Surfaces 

Chart Surface Smoothing 

Displaying Elevation and Contour Data 

Formatting Contouring Options 

Displaying Contour Chart Colors 

Modifying Contour Colors 

Managing Charts

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Exporting Charts 

Loading Saved Charts 

Printing Charts 

Setting Print Options 

Specifying Page Size and Appearance 

Changing Printer Setup 

Dialog Box Help



Welcome to First Impression

Introduction to the Users Guide

Understanding Charts

The Wizard

The Chart Data Grid

Changing the Chart Type

Formatting Chart Elements

Formatting 3D Charts

Formatting Axes

Plot Options

Formatting Series and Data Points

Formatting Labels

Elevation Charts - Surface and Contour 

Managing Charts

Dialog Box Help

The Format Chart Options Tab 

The Format Chart Backdrop Tab 

The Format Plot Type Tab 

The Format Plot Backdrop Tab 

The Format Plot Options Tab 

The Format Plot 3D Lighting Tab 

The Format Plot Location Tab 

The Format Plot Order Tab 

The Format Plot 3D View Tab 

The Format Plot Base and Walls Tab 

The Format Plot Contouring Tab 

The Format Plot Elevation Tab 

The Format Series Options Tab 



The Format Series Fill Tab 

The Format Series Line Tab 

The Format Series Markers Tab 

The Format Series Statistics Tab 

The Format Series Guidelines Tab 

The Format Series Label Options Tab 

The Format Series Label Font Tab 

The Format Series Label Text Tab 

The Format Series Label Backdrop Tab 

The Format Data Point Options Tab 

The Format Data Point Fill Tab 

The Format Data Point Markers Tab 

The Format Data Point Label Options Tab 

The Format Data Point Label Text Tab 

The Format Data Point Label Font Tab 

The Format Data Point Label Backdrop Tab 

The Format Data Point Label Value Format Tab 

The Format Data Point Label Percent Format Tab 

The Format Axis Options Tab 

The Format Axis Grid Tab 

The Format Axis Scale-Category Tab 

The Format Axis Scale-Date Tab 

The Format Axis Scale-Value Tab 

The Format Axis Polar Tab 

The Format Axis Radar Tab 

The Format Axis Ticks Tab 

The Format Axis Label Backdrop Tab 

The Format Axis Label Text Tab 

The Format Axis Label Font Tab 

The Format Axis Label Format Code Tab 

The Format Axis Title Text Tab 

The Format Axis Title Backdrop Tab 

The Format Axis Title Font Tab 

The Format Legend Backdrop Tab 

The Format Legend Font Tab 

The Format Legend Location Tab 

The Format Title Location Tab 

The Format Title Text Tab 

The Format Footnote Location Tab 

The Format Footnote Backdrop Tab 

The Format Footnote Font Tab 



The Format Title Backdrop Tab 

The Format Title Font Tab 

The Format Footnote Text Tab 



Introduction
Support for All Major Chart Types. First Impression includes 2D, 3D, and stacked permutations of bar, 
line, area, and step charts. It also includes XY, polar, radar, gantt, hi-lo, pie, doughnut, elevation, 3D XYZ, 
and 3D scatter charts.

Interactive Chart Formatting. First Impression allows you to use simple point and click techniques to 
easily change chart types, text styles, fill patterns, marker styles, as well as 3D rotation, perspective, 
lighting, and much more.

Plot Multi-Dimensional Data. First Impression easily interprets and charts complex data with multiple 
levels of labels.

True 3D. First Impression offers true 3D representations of chart elements, including the use of projected 
text. It also provides exceptional control of lighting on 3D chart elements.

Ease of Use. First Impression has many features that make it one of the easiest chart controls to use, 
including the complete documentation available through on-line help and endless flexibility for 
customizing the control.



New Features in First Impression 2.1
 DBCS support. First Impression fully supports double byte character sets.
 Uniform Data Transfer. First Impression is now a UDT (uniform data transfer) control. This 

functionality is exhibited in the EditPaste and EditCopy methods and drag-and-drop.
 New Drag-and-Drop functionality. First Impression 2.1 allows you to use drag-and-drop functionality 

to copy data between charts or between First Impression and other applications.
 Cut and Paste of New Clipboard Formats. First Impression now supports cut and paste of clipboard 

tab-delimited text in addition to bitmap and metafile formats.



Getting Technical Support
The Visual Components technical support staff can help you with any problem you encounter installing or 
using First Impression. If you need assistance, contact Visual Components in any of the following ways:

By telephone. You can contact our technical support staff at (913)599-6500 on weekdays between 8:30 
a.m. and 5:30 p.m., central time. 

By FAX. You can contact us by FAX at (913)599-6597.

On the World Wide Web. Contact us at:

WWW.VISUALCOMP.COM 
Via BBS. You can contact us through our 24-hour bulletin board service at (913)599-6713.

By mail. Address your correspondence to:

Technical Support Department
Visual Components, Inc.
15721 College Blvd.
Lenexa, Kansas 66219

In Europe, contact:

Visual Components Europe
Lenexa House
11 Eldon Way
Paddock Wood, Kent
England TN12 6BE
Tel:    +44 1892 834343
Fax: +44 1892 835843
BBS: +44 1892 835579



Chart Terminology
Charts provide a graphical representation of data. Values or data points are displayed in formats such as: 
bars, lines, markers, filled areas, bubbles, or pie slices. These data points are grouped into series that are
identified with unique colors or patterns. In many chart types, one data point from each series is grouped 
together by category along an axis.

Related Topics:
General Chart Elements 
2D Chart Elements 
3D Chart Elements 
Selecting Chart Elements 
Formatting Chart Elements 
Double-clicking on Chart Elements 
Using Dialog Boxes 



General Chart Elements
Charts can also have titles, backdrops, legends, plots, and footnotes. The following illustration identifies 
these common chart elements in their default positions. 

Related Topics:
Chart Terminology 
2D Chart Elements 
3D Chart Elements 
Selecting Chart Elements 
Formatting Chart Elements 
Double-clicking on Chart Elements 
Using Dialog Boxes 



2D Chart Elements
The following illustration identifies the elements in a typical 2D chart.

Related Topics:
Chart Terminology 
General Chart Elements 
3D Chart Elements 
Selecting Chart Elements 
Formatting Chart Elements 
Double-clicking on Chart Elements 
Using Dialog Boxes 



3D Chart Elements
The following illustration identifies the elements in a typical 3D chart.

Related Topics:

Chart Terminology 

General Chart Elements 

2D Chart Elements 

Selecting Chart Elements 

Formatting Chart Elements 

Double-clicking on Chart Elements 

Using Dialog Boxes 



Selecting Chart Elements
You can click the left mouse button once on a chart element to select it. The following table provides 
information about selecting each chart element.

To select... Click... Effect
Chart In the chart, but not on a specific chart element. Selection handles appear around the 

chart. 

Chart title Anywhere in the title area. Selection handles appear around the 
title. You can resize or reposition it.

Footnote Anywhere in the footnote area. Selection handles appear around the 
footnote. You can resize or reposition it.

Legend In the legend, but not the legend keys. Selection handles appear around the 
legend. You can resize or reposition it.

Series On an element in an unselected series, or on the
legend key identifying the series.

Selection handles appear on all 
elements of chart series. Handle also 
appears on legend key.

Series Label Anywhere in the series label. Selection handles appear around the 
label. You can reposition it.

Plot In the plot, but not on a specific chart element. Selection handles appear around the 
chart plot. You can resize or reposition 
it.

Axis On the axis text, axis line, or axis ticks. Selection handles appear on the axis. 
You cannot manually resize the axis.

Axis title Anywhere in the axis title area. Selection handles appear around the 
axis title. 

Chart grid On any grid line. Selection handles appear around the 
grid. 

2D wall and 3D wall or base Any part of the base or wall other than a grid 
line.

Selection handles appear around the 
wall in a 2D chart, and the base and 
wall in a 3D chart. 

Data point Click on a data point in a selected series, or on a
data point in the same series as another 
selected data point. 

Selection handles appear on the single 
data point only.

Data point label Anywhere in the data point label. Selection handles appear around the 
data point label. You can reposition it.

Related Topics:

Chart Terminology 

General Chart Elements 

2D Chart Elements 

3D Chart Elements 

Formatting Chart Elements 

Double-clicking on Chart Elements 

Using Dialog Boxes 



Formatting Chart Elements
You can format any element of a First Impression chart by changing settings in a dialog box. First 
Impression dialog boxes can be displayed by making a selection from a menu or by double-clicking the 
appropriate chart element.

Click the right mouse button anywhere within a First Impression chart to display the floating menu. Once 
the menu appears, use the left mouse button to select a menu item. Clicking on menu items followed by 
three periods displays a submenu as shown in the following illustration.

The following table describes the purpose of each item on the floating menu.
Item Dialog Box Displayed Purpose
Wizard Chart Wizard Guides you through chart design 

process.

Edit Chart Data Data Grid Editor Modifies the data, rows, columns, and 
labels in the data grid.

General Format Chart Formats the fill, frame, and shadow 
displayed in the chart backdrop and 
provides a convenient place to toggle 
on and off the display of the title, the 
legend, the footnote or the 2nd Y axis.

Plot Format Plot Changes the chart type, stacks or 
unstacks chart series, turns lines and 
markers on or off, controls the location 
of the plot, formats the plot backdrop, 
reorders series, sets chart-type specific
options, and controls 3D chart 
formatting and lighting.

Series Format Series Controls the display of series, plots a 
series on a secondary axis, formats 
series appearance such as bar shape, 
line style, markers, and fill colors, sets 
series smoothing, and formats statistics
lines and guidelines.

Label Format Series Label Controls the series label location and 
line style, edits the label text, formats 
the label text and position, and formats 
the label backdrop.

Data Point Format Data Point Formats the fill and marker for an 
individual data point.



Data Point Label Format Data Point Label Controls the type and location of the 
label on an individual data point, 
formats the font and layout of the label 
text, and formats the label backdrop.

Axis Format Axis Formats the width and color of the axis,
axis grid, and axis ticks, and changes 
axis scale.

Label Format Axis Label Formats the axis label backdrop and 
font, and controls the positioning and 
alignment of the axis labels.

Title Format Axis Title Formats the axis title backdrop and 
font, edits the axis title text, and 
controls the display of the axis title and 
its location.

Legend Format Legend Formats the legend backdrop, changes
the font used to display the legend text,
and controls the legend location.

Title Format Title Formats the title backdrop and font, 
edits the title text, and controls the 
display of the title and its location.

Footnote Format Footnote Formats the footnote backdrop and 
font, edits the footnote text, controls the
display of the footnote and its location.

Copy None Places a copy of the current chart on 
the clipboard in Windows Metafile 
(.wmf) format.

Paste None Takes a graphic in Windows Bitmap 
(.bmp) or Windows Metafile (.wmf) 
format from the clipboard and places it 
in the selected elements backdrop or 
fill.

Print Print Displays the Print dialog box.

Save As Save As Saves the current file as a chart file 
(.vtc), a bitmap (.bmp), or a metafile 
(.wmf).

Load Load Chart Loads an existing chart file into the 
current chart control. The chart you 
load replaces the chart already in the 
control.

If you use the menu to display the Format Axis, Format Axis Title, Format Axis Label, Format Series, 
Format Series Label, Format Data Point, or Format Data Point Label dialog boxes, you are prompted to 
identify the specific axis, series, or data point you want to modify.

Related Topics:

Chart Terminology 

General Chart Elements 

2D Chart Elements 

3D Chart Elements 

Selecting Chart Elements 



Double-clicking on Chart Elements 

Using Dialog Boxes 



Double-Clicking on Chart Elements
You can also display First Impression dialog boxes by double-clicking chart elements. The following table 
lists the dialog box displayed when you double-click various chart elements.

To format... Double-click... Dialog Box Tab
Chart Backdrop The chart but not on a 

specific chart element
Format Chart Backdrop

Footnote Any part of the footnote Format Footnote Text

Title Any part of the title Format Title Text

Legend Backdrop Anywhere in the legend area
other than the text or keys

Format Legend Backdrop

Legend Text The legend text Format Legend Font

Plot Anywhere in the plot area, 
but not on a specific chart 
element

Format Plot Backdrop

Axis Label An axis label Format Axis Label Font

Axis Line or Ticks The line or ticks on an axis Format Axis Scale

Axis Title The axis title text Format Axis Title Text

Grid Any grid line Format Axis Grid

3D Base or Wall Anywhere on the base or 
wall other than a grid line

Format Plot Base & Walls

Series A chart element in an 
unselected series or the 
legend key identifying the 
series

Format Series Line for line type series

Fill for all others

Data Point A selected data point, or a 
point in the same series as a
selected data point

Format Data Point Options or Fill if series 
defaults have been 
overridden

Series Label The series label Format Series Label Text

Data Point Label The data point label Format Data Point Label Options or Text if series 
defaults have been 
overridden

Related Topics:

Chart Terminology 

General Chart Elements 

2D Chart Elements 

3D Chart Elements 

Selecting Chart Elements 

Formatting Chart Elements 

Using Dialog Boxes 



Using Dialog Boxes
Most First Impression dialog boxes provide sets of options grouped on separate tabs. As you click each 
tab, the controls in the dialog box change to allow you to edit a different set of options. Any options that 
are not appropriate for the current chart type or situation are grayed. The following illustration shows an 
example of a First Impression dialog box.

Click on a button or tab to learn what it does.

Related Topics:

Chart Terminology 

General Chart Elements 

2D Chart Elements 

3D Chart Elements 

Selecting Chart Elements 

Formatting Chart Elements 

Double-clicking on Chart Elements 



3D View Tab
Displays the 3D View tab to set options for viewing a 3D chart.



3D Lighting Tab
Displays the 3D Lighting tab to set lighting options for a 3D chart.



Base and Walls Tab
Displays the Base and Walls tab to set base and wall options for a chart.



Location Tab
Displays the Location tab to set options for positioning chart elements.



Backdrop Tab
Displays the Backdrop tab to set options for plot backgrounds.



Order Tab
Displays the Order tab for reordering chart series.



Options Tab
Displays the general chart options tab.



OK Button
Click Ok to update the chart and dismiss the dialog box.



Cancel Button
Click Cancel to discard any changes you have not applied and dismiss the dialog box.



Help Button
Click Help to display help for the dialog box options.



Apply Button
Click Apply to update the chart without dismissing the dialog box.



The Chart Wizard
The Chart Wizard is a series of tabbed dialog boxes that guides you through the process required to 
create a new First Impression chart or modify an existing chart for use with your application. With the 
Chart Wizard, you can quickly accomplish many design tasks that would otherwise take much longer to 
complete.

To Access the Chart Wizard:

1. Right-click the chart control on the form.

2. Select Wizard from the menu.

The Chart Wizard tabbed dialog will display.

To learn how to use the chart wizard, see Navigating in the Chart Wizard.

Related Topics:

The Gallery Tab 

The Style Tab 

The Layout Tab 

The Axes Tab 

Modifying Charts with the Wizard 



Navigating in the Chart Wizard
The Chart Wizard provides four tabs that control various design aspects such as choosing a chart type, 
setting chart options, controlling chart layout, and specifying chart and axis titles. You can navigate 
through these tabs by clicking on the tab at the top of the dialog box, or by using the navigation buttons at
the bottom of the dialog box

Click on the navigational buttons to learn what they do.

Related Topics:

The Chart Wizard 

The Gallery Tab 

The Style Tab 

The Layout Tab 

The Axes Tab 

Modifying Charts with the Wizard 



The Gallery Tab
The Gallery Tab allows you to select the type of chart you wish to design. Two radio buttons allow you    to
differentiate between 2D chart types and 3D chart types.

Click on buttons to learn what they do.

Related Topics:

The Chart Wizard 

Navigating in the Chart Wizard 

The Style Tab 

The Layout Tab 

The Axes Tab 

Modifying Charts with the Wizard 



Wizard 2D Radio Button
Click here to display 2D chart types.



Wizard 3D Radio Button
Click here to display 3D chart types.



The Style Tab
The Style Tab lets you set the style for the chart type you have selected. By using the style tab, you can 
easily set chart display options such as series labels, stacking and bar gap.

Click on buttons to learn what they do.

Related Topics:

The Chart Wizard 

Navigating in the Chart Wizard 

The Gallery Tab 

The Layout Tab 

The Axes Tab 

Modifying Charts with the Wizard 



The Layout Tab
The Layout Tab provides methods for determining the elements and layout of the chart plot. 

Click on buttons and text boxes to learn what they do.

Related Topics:

The Chart Wizard 

Navigating in the Chart Wizard 

The Gallery Tab 

The Style Tab 

The Axes Tab 

Modifying Charts with the Wizard 



Chart Title Text Box
The Chart Title text box allows you to enter the title you wish to display above the chart.



Chart Footnote Text Box
The Chart Footnote text box allows you to enter a footnote to display beneath the chart



Chart Legend Pop Up Menu
The Chart Legend pop up menu provides options for displaying the chart legend. The options include:

{bmc BULLET.BMP} Bottom      The legend is displayed beneath the chart.

 Left      The legend is displayed to the left of the chart.
 None      No legend is displayed with the chart.
 Right      The legend is displayed to the right of the chart.
 Top      The legend is displayed at the top of the chart.



Series Data Radio Buttons
Click on a button to determine how series data is read from the data grid. The two choices for reading 
series data include:

Rows      Series data is read from rows of the data grid.
Columns      Series data is read from columns of the data grid.



The Axes Tab
The Axes Tab allows you to label chart axes.

Click on buttons and text boxes to learn what they do.

Related Topics:

The Chart Wizard 

Navigating in the Chart Wizard 

The Gallery Tab 

The Style Tab 

The Layout Tab 

Modifying Charts with the Wizard 



Category Text Box
The Category text box allows you to label the X axis for the chart.

The X axis is referred to as the Category axis.



Value Text Box
The Value text box allows you to label the Y axis for the chart.

The y axis is referred to as the value axis.



Depth Text Box
The Depth text box allows you to label the Z axis for the chart.

The Z axis is referred to as the depth axis.



Secondary Text Box
The Secondary text box allows you to label the secondary Y axis (Y2) for the chart.



Modifying Charts with the Wizard
When you use the chart wizard to modify existing charts, the wizard will initialize the chart back to its 
default settings and then restore only those features it controls in the Gallery, Layout, and Axes tabs.    
You will want to exercise care when modifying existing charts that may have originally been created 
without the wizard. You may need to manually adjust some chart settings after using the wizard.

Related Topics:

The Chart Wizard 

Navigating in the Chart Wizard 

The Gallery Tab 

The Style Tab 

The Layout Tab 

The Axes Tab 



Wizard Help Button
Displays Wizard Help.



Wizard Cancel    Button
Aborts Changes.



Wizard Back Button
Displays Previous Tab.



Wizard Next Button
Displays Next Tab.



Wizard Finish Button
Applies Modifications.



Chart Data Grid
Each chart is associated with a data grid. This data grid is a table that holds the data being charted. The 
data grid can also include labels used to identify series and categories on the chart. The person who 
designs your chart application fills the data grid with information by inserting data, or by importing data 
from a spreadsheet or array. 

The following illustration shows the relationship between a data grid and a chart.

In most cases, each column in the data grid translates to one series on the chart. However, First 
Impression supports a number of chart types that require two or more columns of data to chart a series. 
These chart types include XY Charts , polar, bubble, hi-lo, and gantt charts. 

Note       You may be formatting a chart in an application designed for you by someone else. To use 
one of the chart types that requires more than one column of data for a series, you may need to have 
the chart designer familiarize you with the structure of the chart data. If you are attempting to design a
chart, refer to the First Impression Reference Information for more information about data grids.

Related Topics:

The DataGrid Editor

Resizing the Data Grid

Modifying Data in the Data Grid



The DataGrid Editor
You can easily modify the data in the Data Grid by using the Data Grid Editor. 

To Access the Data Grid Editor

1. Right-click the chart control on the form to display the floating menu.

2. Choose Edit Chart Data... from the menu.

The Data Grid Editor dialog will display.

Click on the Data Grid Editor buttons and menus to learn their function.
Related Topics:
Chart Data Grid 
Resizing the Data Grid 
Modifying Data in the Data Grid 



Resizing the Data Grid
Since the chart grid is initially filled with random data, you might want to start by resizing the data grid to 
agree with the size of the worksheet containing your data. You can resize the grid simply by indicating the 
correct number of rows and columns of your worksheet in the Data Grid Editor. You can also indicate the 
number of levels of labels the rows and columns have. 

To Resize the Data Grid for 8 Rows and Columns of Data:

1. Double-click the mouse cursor in the Rows field of the Editor dialog to select the current row value.

2. Type the number 8.

3. Tab to the Columns field.

The Data Grid will redisplay to reflect the change in number of rows.

4. In the Columns field, type the number 8.

5. Tab to exit the Columns field.

The data grid should now display 8 columns and 8 rows. The additional column and row cells will 
appear empty.

Important       Although the grid redisplays as you exit a cell, thoses changes have not yet been 
applied to the chart. You must click Apply or OK to affect the chart.

Related Topics:

Chart Data Grid

The DataGrid Editor

Modifying Data in the Data Grid



Modifying Data in the Data Grid
Once you have resized the data grid to accommodate your worksheet data, you are ready to modify the 
data in the grid. 

To Modify The Data In The Grid:

1. Use the mouse or navigation keys to select the desired cell.

2. The cell location will be highlighted by a thick black border, indicating that the cell is active.

3. Once the cell is active, type the new data value.

4. The cell will display the new value and replace the previous value once you have exited the cell. 
You may exit the grid cell by navigational keys or the Enter key.

Related Topics:

Chart Data Grid

The DataGrid Editor

Resizing the Data Grid

Adding Row and Column Labels

Modifying Row and Column Labels 



Adding Row and Column Labels
The Data Grid Editor provides an easy method for changing the number of    row and column labels. 

To add Row Labels and Column Labels.

1. Double-click the mouse cursor in the Row Labels field of the Editor dialog to select the current 
number of row labels.

2. Type the number of desired row labels.

3. Tab to the Column Labels field.

The Data Grid will redisplay to reflect the change in number of row labels.

4. In the Column Labels field, type the number of desired column labels.

5. Tab to exit the Column Labels field.

The data grid should now display additional column and row labels.

Remember      You must click Apply or OK to affect the chart.

Once you have added row and column labels, you are ready to modify the row and column labels.

Related Topics:

Chart Data Grid 

The DataGrid Editor 

Resizing the Data Grid 

Modifying Data in the Data Grid 

Modifying Row and Column Labels 



Modifying Row and Column Labels
You can change data grid labels in a few simple steps.

To Modify Row and Column Labels In The Grid:

1. Use the mouse cursor or navigational keys to select the desired cell.

2. The cell location will be highlighted by a thick black border, indicating that the cell is active.

3. Once the cell is active, type the new label.

4. The cell will display the new label and replace the previous label once you have exited the cell. 
You may exit the grid cell by navigational keys or the Enter key.

Related Topics:

Modifying Data in the Data Grid 

Adding Row and Column Labels 

Inserting a Data Grid Row

Inserting a Data Grid Column 

Deleting a Data Grid Row

Deleting a Data Grid Column 

Inserting a Column of Data Grid Row Labels

Inserting a Row of Data Grid Column Labels  

Deleting a Column of Data Grid Row Labels 

Deleting a Row of Data Grid Column Labels 



The Menu Bar
The Data Grid Editor menu bar contains three menus which provide methods to simplify the data editing 
process.

Click on the Data Grid Editor Menus to learn what they do.
Related Topics:
Inserting a Data Grid Row
Inserting a Data Grid Column
Deleting a Data Grid Row 
Deleting a Data Grid Column
Inserting a Column of Data Grid Row Labels 
Inserting a Row of Data Grid Column Labels 
Deleting a Column of Data Grid Row Labels
Deleting a Row of Data Grid Column Labels 



Inserting a Data Grid Row
You can insert rows in a few simple steps:

To Insert a Data Grid Row:

1. Use the mouse or navigational keys to move to the desired cell location.

2. The cell location will be highlighted by a thick black border, indicating that the cell is active.

3. Once the cell is active, select Row from the Insert menu.

4. An entire data grid row will be inserted at that point in the grid, moving the current row down one 
level.

Related Topics:

Inserting a Data Grid Column 

Deleting a Data Grid Row

Deleting a Data Grid Column 

Inserting a Column of Data Grid Row Labels 

Inserting a Row of Data Grid Column Labels  

Deleting a Column of Data Grid Row Labels

Deleting a Row of Data Grid Column Labels  



Inserting a Data Grid Column
You can insert columns in a few simple steps.

To Insert a Data Grid Column:

1. Use the mouse or navigational keys to move to the desired cell location.

2. The cell location will be highlighted by a thick black border, indicating that the cell is active.

3. Once the cell is active, select Column from the Insert menu.

4. An entire data grid column will be inserted at that point in the grid, moving the current column one 
position to the right.

Related Topics:

Inserting a Data Grid Row

Deleting a Data Grid Row 

Deleting a Data Grid Column 

Inserting a Column of Data Grid Row Labels 

Inserting a Row of Data Grid Column Labels  

Deleting a Column of Data Grid Row Labels 

Deleting a Row of Data Grid Column Labels  



Deleting a Data Grid Row
You can easily delete an entire row from your data grid.

To Delete a Data Grid Row:

1. Use the mouse or navigational keys to move to the desired cell location.

2. The cell location will be highlighted by a thick black border, indicating that the cell is active.

3. Once the cell is active, select Row from the Delete menu.

4. The entire data grid row will be deleted at that point, moving the row below the current cell location 
up to the current position.

Related Topics:

Inserting a Data Grid Row

Inserting a Data Grid Column 

Deleting a Data Grid Column

Inserting a Column of Data Grid Row Labels 

Inserting a Row of Data Grid Column Labels  

Deleting a Column of Data Grid Row Labels 

Deleting a Row of Data Grid Column Labels 



Deleting a Data Grid Column
You can easily delete an entire column from your data grid.

To Delete a Data Grid Column:

1. Use the mouse or navigational keys to move to the desired cell location.

2. The cell location will be highlighted by a thick black border, indicating that the cell is active.

3. Once the cell is active, select Column from the Delete menu.

4. The entire data grid column will be deleted at that point, moving the column to the right of the 
current cell location left one position.

Related Topics:

Inserting a Data Grid Row

Inserting a Data Grid Column

Deleting a Data Grid Row 

Inserting a Column of Data Grid Row Labels 

Inserting a Row of Data Grid Column Labels  

Deleting a Column of Data Grid Row Labels 

Deleting a Row of Data Grid Column Labels  



Inserting a Column of Data Grid Row Labels
You can easily add an entire column of row labels.

To Insert a Column of Data Grid Row Labels:

1. Use the mouse or navigational keys to move to the desired row label location.

2. The row label location will be highlighted by a thick black border, indicating that the cell is active.

3. Once the cell is active, select Row Label from the Insert menu.

4. Choose Before to insert a column of row labels to the left of the currently selected label. Choose 
After to insert a column of row labels to the right of    the currently selected label.

Related Topics:

Inserting a Data Grid Row

Inserting a Data Grid Column 

Deleting a Data Grid Row 

Deleting a Data Grid Column 

Inserting a Row of Data Grid Column Labels  

Deleting a Column of Data Grid Row Labels 

Deleting a Row of Data Grid Column Labels 



Inserting a Row of Data Grid Column Labels
You can easily add a row of column lables.

To Insert a Row of Data Grid Column Labels

1. Use the mouse or navigational keys to move to the desired column label location.

2. The column label location will be highlighted by a thick black border, indicating that the cell is 
active.

3. Once the cell is active, select Column Label from the Insert menu.

4. Choose Before to insert a row of column labels above the currently selected label. Choose After to 
insert a row of column labels below the currently selected label

Related Topics:

Inserting a Data Grid Row

Inserting a Data Grid Column 

Deleting a Data Grid Row

Deleting a Data Grid Column 

Inserting a Column of Data Grid Row Labels 

Deleting a Column of Data Grid Row Labels

Deleting a Row of Data Grid Column Labels 



Deleting a Column of Data Grid Row Labels
You can easily delete an entire column of row labels.

To Delete a Column of Data Grid Row Labels:

1. Use the mouse or navigational keys to move to the desired row label location.

2. The row label location will be highlighted by a thick black border, indicating that the cell is active.

3. Once the cell is active, select Row Label from the Delete menu.

4. The entire column of row labels will be deleted at that point in the grid, moving the existing row 
labels left one position.

Related Topics:

Inserting a Data Grid Row 

Inserting a Data Grid Column 

Deleting a Data Grid Row

Deleting a Data Grid Column

Inserting a Column of Data Grid Row Labels 

Inserting a Row of Data Grid Column Labels  

Deleting a Row of Data Grid Column Labels  



Deleting a Row of Data Grid Column Labels
You can easily delete a row of column labels.

To Delete a Row of Data Grid Column Labels:

1. Use the mouse or navigational keys to move to the desired column label location.

2. The column label location will be highlighted by a thick black border, indicating that the cell is 
active.

3. Once the cell is active, select Column Label from the Delete menu.

4. A row of column labels will be deleted at that point in the grid, moving the existing row labels up 
one position.

Related Topics:

Inserting a Data Grid Row 

Inserting a Data Grid Column 

Deleting a Data Grid Row 

Deleting a Data Grid Column 

Inserting a Column of Data Grid Row Labels 

Inserting a Row of Data Grid Column Labels  

Deleting a Column of Data Grid Row Labels 



Using Drag-and-Drop Functionality to Copy Data
First Impression provides drag-and-drop functionality to copy data between two First Impression 
applications or between First Impression and other applications that support drag-and-drop.

To use drag-and-drop within First Impression:
If you have two charts, or two First Impression applications, you can copy chart data between the two.

1. At run-time, select the chart you want to copy from.

2. Position the mouse pointer near the edge of the plot area and then hold down the mouse button. 

When the  pointer appears, drag the pointer to the other chart. You must select the chart for 
dragging at the plot's edge; you cannot drag from directly on top of the chart.

3. With the mouse button held down, move to the second chart. When you have the mouse pointer 
positioned over the other chart, release the mouse. The chart will redraw to reflect the copied data. The 
dropped data will be copied into the data grid. Any previous data in the grid will be replaced with the 
dropped data.
To drag data from another application and drop it into First Impression:

1. Arrange the application windows so that the source and destination documents are open and 
visible. You must be able to see the information you want to drag and the First Impression chart 
you want to place it on.

2. Select the information you want to copy and position the mouse pointer near the border of the 
selected area. Press and hold down the mouse button.

3. Begin dragging the selection away from the application. The     pointer will appear when the 
data can be dropped. Drag the pointer to the First Impression chart and then release the mouse 
button. The chart will redraw to reflect the copied data.

Note: Data must be copied to the First Impression application at run-time only.

To drag data from First Impression to another application:

1. Arrange the application windows so that the source and destination documents are open and 
visible.

2. At run-time, select the chart you want to copy data from.

3. To copy the information, position the mouse pointer near the edge of the plot area and then hold 

down the mouse button. The  pointer will appear. You must select the chart for dragging at the
plot's edge; you cannot drag from directly on top of the chart. With the chart selected, drag the 
pointer to the other application and release the mouse button. 

Note: The drag-and-drop functionality will only work with applications that support Windows CF_TEXT 
and CF_METAFILEPICT data. When dragging and dropping data between applications, the source 
application notifies the receiver application which data types it can supply, i.e., CF_TEXT, 
CF_METAFILEPICT, or both. It is ultimately the decision of the receiving application as to which format it 
actually uses. For example, if you drag a First Impression chart to a spreadsheet application, the 
spreadsheet application is likely to display only the textual data even though First Impression is offering 
either format. If you wish to paste the Metafile of the chart itself, you might try using Copy and Paste 
Special from the Edit menu so you can specify the format you want to paste into the spreadsheet.

Drag-and-Drop Between First Impression and Formula One



Drag-and-Drop Between First Impression and Formula One
When dragging and dropping data between First Impression and Formula One, you can establish an 
interactive link between the applications. With an established link, when data is modified in the sheet the 
chart will repaint to reflected the changes in data immediately.

To establish a link when dragging and dropping data from Formula One:
1. Select the data in the Formula One worksheet that you wish to copy to the chart.

2. Position the mouse pointer near the border of the selected data. Hold down the Shift and Control 
keys on the keyboard while you click the mouse button. 

3. While holding down the Shift and Control keys and the mouse button, drag the selected data to 

the chart. The mouse pointer will change to  when you have successfully positioned the 
cursor over the chart. Release the mouse button. The data will be copied to the chart creating an 
interactive link between the worksheet and the chart. From this point on, when data is modified in 
the Formula One worksheet, First Impression will automatically display the changes.

Note: You must drag data to First Impression at run-time only.

Using Drag-and-Drop Functionality to Copy Data



Area Charts
Use area charts to emphasize the relative importance of values over a period of time. An area chart 
focuses on the magnitude of change rather than the rate of change. Each filled-area on the chart 
represents a series and is identified by a different color or pattern. Values are plotted on the vertical (Y) 
axis and categories are plotted on the horizontal (X) axis. You can also chart one or more series against 
the secondary Y axis instead of the primary axis.

Related Topics:
Bar Charts Horizontal Bars 

Clustered Bars Line Charts 

Step Charts Combination Charts 

Pie and Doughnut Charts Radar Charts 

XY Charts Polar Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Bar Charts
Use bar charts to compare one item to another, or to compare a number of items over a period of time. 
These charts are particularly effective at showing large changes from one category to another. Each 2D 
or 3D bar represents a value in the data grid. Bars representing a series are located at the same position 
in each category and have the same color and pattern. In 2D charts, values are grouped on the vertical 
(Y) axis, and bars are grouped by category along the horizontal (X) axis. On 3D charts, values are plotted 
on the vertical (Y) axis, categories are grouped along the horizontal (X) axis, and the depth (Z) axis shows
series.



Related Topics:
Area Charts Horizontal Bars 

Clustered Bars Line Charts 

Step Charts Combination Charts 

Pie and Doughnut Charts Radar Charts 

XY Charts Polar Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Horizontal Bars

Horizontal bars are similar to standard bar charts except that the categories are organized on a vertical 
(X) axis and the values are plotted on a horizontal (Y) axis. 
Related Topics:

Area Charts Bar Charts 

Clustered Bars Line Charts 

Step Charts Combination Charts 



Pie and Doughnut Charts Radar Charts 

XY Charts Polar Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Clustered Bars
Series and data points in a clustered bar chart are displayed as they are in a 2D bar chart, however the 
chart and all the chart elements are displayed in 3D.

Related Topics:
Area Charts Bar Charts 

Horizontal Bars Line Charts 

Step Charts Combination Charts 

Pie and Doughnut Charts Radar Charts 

XY Charts Polar Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Line Charts
Use line charts to show trends or changes in data over a period of time. These charts emphasize time 
flow and rate of change rather than amount of change. In 2D line charts, values are plotted along the 
vertical (Y) axis and categories are displayed on the horizontal (X) axis. In 3D charts, values are plotted 
on the vertical (Y) axis, categories are grouped along the horizontal (X) axis, and the depth (Z) axis shows
series. 



Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Step Charts Combination Charts 

Pie and Doughnut Charts Radar Charts 

XY Charts Polar Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Step Charts
Use step charts to compare items that do not show trends. Step charts display distinct points along the 
value (Y) axis, with vertical lines showing the difference between each point. The horizontal (X) axis 
shows categories. 

Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Combination Charts 

Pie and Doughnut Charts Radar Charts 



XY Charts Polar Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Combination Charts
Use combination charts to visually highlight the differences between multiple series of data. A different 
method can be used to draw each data series.    

Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Pie and Doughnut Charts Radar Charts 

XY Charts Polar Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Pie and Doughnut Charts
Use pie or doughnut charts to show the relationship of parts to the whole. Each pie or doughnut 
represents a category. Each slice of the pie or doughnut represents a value in that category. You can 
separate or explode slices in a chart by clicking a slice and dragging it away from the rest of the pie or 
doughnut. 



Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Combination Charts Radar Charts 

XY Charts Polar Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Radar Charts
Use radar charts to show changes or frequencies of each series relative to a center point and to one 
another. Lines connect all the data markers in the same series. You can choose to fill the lines, thereby 
creating a radar area chart. 

Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Combination Charts Pie and Doughnut Charts 

XY Charts Polar Charts 



Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

XY Charts
Use XY charts to plot two groups of numbers as one series of XY coordinates. Each series on the chart 
requires two columns of data in the data grid. The first column holds the X coordinate and the second 
column the Y coordinate. The column label on the first column in each series is used to identify the series 
in the legend. Additionally, any formatting applied to the first column is used to display the series on the 
chart. Any formatting applied to the second column is ignored. You can use markers or lines or both to 
draw the XY points. 

Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Combination Charts Pie and Doughnut Charts 

Radar Charts Polar Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Polar Charts
Use polar charts to show cyclical trends. The polar chart requires two columns in the data grid for each 
chart series: the first column holds the distance from the center of the chart (the radius), and the second 
column contains the angle on the perimeter of the chart. The column label on the first column in each 
series identifies the series in the legend. Additionally, any formatting applied to the first column is used to 
display the series on the chart. Any formatting applied to the second column is ignored. 



Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Combination Charts Pie and Doughnut Charts 

Radar Charts XY Charts 

Bubble Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Bubble Charts
Use bubble charts to show a visual comparison using three coordinates. Each bubble requires three 
columns of data in the data grid. The first column holds the X coordinate, the second the Y coordinate, 
and the third the bubble size. All the coordinates in a bubble chart measure values; therefore, the vertical 
(Y) axis and the horizontal (X) axis both show values. The column label on the first column in each series 
identifies the series in the legend. Additionally, any formatting applied to the first column is used to display
the series on the chart. Any formatting applied to the second and third columns is ignored. 

Related Topics:
Area Charts Bar Charts 



Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Combination Charts Pie and Doughnut Charts 

Radar Charts XY Charts 

Polar Charts Hi-Lo Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Hi-Lo Charts
Hi-lo charts are most commonly used to show stock market information. However, these chart types can 
also be used for scientific data such as indicating changes in readings over a period of time. The vertical 
(Y) axis shows values and the horizontal (X) axis shows categories or dates.

First Impression supports a number of variations to the hi-lo charts. These include: hi-lo-close with the 
close marker crossing the data point or extending to the right of the data point, open-hi-lo-close, and 
open-hi-lo-close bar.

The data in the data grid must be organized appropriately for each variation of the hi-lo chart.
A hi-lo chart requires two columns for each data series: the first column is used for the high point 

and the second is used for the low point.
A hi-lo-close chart requires three columns for each data series: the first column is used for the 

high point, the second for the low point, and the third for the closing point.
An open-hi-lo-close or a open-hi-lo-close bar chart (sometimes called candle stick charts) 

requires four columns of data for each data series: the first column is used for the open point, the second 
for the high point, the third for the low point, and the fourth for the closing point.
The column label on the first column in each series identifies the series in the legend. Additionally, any 
formatting applied to the first column is used to display the series on the chart. Any formatting applied to 
the remaining columns that make up the series are ignored.

Related Topics:



Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Combination Charts Pie and Doughnut Charts 

Radar Charts XY Charts 

Polar Charts Bubble Charts 

Gantt Charts Elevation Charts: Surface and Contour 

3D XYZ Charts 3D Scatter Charts 

Gantt Charts
Use gantt charts to display a range of bars that indicate the relative time required for various activities 
within a project. The horizontal axis (Y) shows dates and the vertical axis (x) shows categories. This chart
type requires two columns of data for each series. The first column holds the start date, and the second 
column holds the duration. 

Related Topics:
Area Charts 3D Scatter Charts 

Horizontal Bars Bar Charts 

Line Charts Clustered Bars 

Combination Charts Step Charts 

Radar Charts Pie and Doughnut Charts 

Polar Charts XY Charts 

Hi-Lo Charts Bubble Charts 

Elevation Charts: Surface and Contour 3D XYZ Charts 

Elevation Charts: Surface and Contour



Elevation charts are commonly used to display topographic data. There are two types of elevation charts: 
contour charts and 3D surface charts.

A contour chart is drawn as a two-dimensional area. Changes in the data plotted on this chart are 
demonstrated through variations in color known as contours. Contours are drawn on the chart as either 
colored bands or lines. Contour bands can be represented on the chart in dramatic contrast or as a subtle
transition in hue known as gradient. Contour charts do not have a value axis; the variation in color is 
represented in the legend instead.

A surface chart is drawn as a rectangular grid with a surface base or floor. The value axis is drawn 
perpendicular to the chart base giving the chart its three-dimensional quality. Data variations are plotted 
on this chart at raised elevations from the surface. The data points themselves are plotted on grid 
intersections at the corresponding value axis elevation, thus giving the chart depth. 

Contours can be applied to surface charts to display additional information.    These variations in color 
bands or lines are projected on the charts three-dimensional surface and can demonstrate a separate 
collection of data independent of elevation.

Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Combination Charts Pie and Doughnut Charts 

Radar Charts XY Charts 

Polar Charts Bubble Charts 

Hi-Lo Charts Gantt Charts 

3D XYZ Charts 3D Scatter Charts 



3D XYZ Charts
This chart shows variation and relationships over three sets of values plotted on a three-dimensional grid. 
Each data point represents the intersection of the X,Y, and Z axes. Each series on the chart requires 
three columns of data in the data grid. The first column holds the x coordinates, the second column holds 
the y coordinates and the third column holds the z coordinates.

Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Combination Charts Pie and Doughnut Charts 

Radar Charts XY Charts 

Polar Charts Bubble Charts 

Hi-Lo Charts Gantt Charts 

Elevation Charts: Surface and Contour 3D Scatter Charts 

3D Scatter Charts
This chart is drawn as a three-dimensional grid with a base and walls. It plots data points created by the 
intersection of three different coordinate values. Each of the three values that make up a point 
corresponds to a particular axis in a 3D grid. Each series on the chart requires three columns of data in 
the data grid. The first column holds the x coordinates, the second column holds the y coordinates and 
the third column holds the z coordinates.



Related Topics:
Area Charts Bar Charts 

Horizontal Bars Clustered Bars 

Line Charts Step Charts 

Combination Charts Pie and Doughnut Charts 

Radar Charts XY Charts 

Polar Charts Bubble Charts 

Hi-Lo Charts Gantt Charts 

Elevation Charts: Surface and Contour 3D XYZ Charts 

The Editor Apply Button
Apply data grid changes to the chart.



The Editor OK    Button
Apply data grid changes and exit the dialog simultaneously.



The Editor Cancel Button
Exit the data grid editor without applying changes.



The Editor Help Button
Displays Data Grid Editor Help.



The Edit Menu

The Edit menu allows you to cut, copy and paste data between cells in the data grid editor.



The Insert Menu

The Insert Menu allows you to insert data grid rows, columns and row and column labels.



The Delete Menu

The Delete Menu allows you to delete data grid rows, columns and row and column labels.



Grid Size Rows
Double-click this value and enter a new one to modify the number of rows in the data grid. 



Grid Size Columns
Double-click this value and enter a new one to modify the number of columns in the data grid.



Grid Size Row Labels
Double-click this value and enter a new one to modify the number of row labels in the data grid.



Grid Size Column Labels
Double-click this value and enter a new one to modify the number of column labels in the data grid.



Data Grid Rows and Columns
Click to select a cell in a row or column and enter a new value to modify the data.



Data Grid Row Labels
Click to select a row label cell and enter a new value to modify the data.



Data Grid Column Labels
Click to select a column label cell and enter a new value to modify the data.



The Format Plot Dialog
There are a number of variations for several of the chart types. For example, you can choose to stack 
some charts or determine whether lines or markers represent chart elements. One of the ways chart 
types and variations are controlled is by setting options in the Type tab of the Format Plot dialog.

To display the Format Plot dialog box:

1. Double-click the chart plot; or, use the right mouse button to display the floating menu and select 
Plot.

The Format Plot dialog box is displayed.

2. If necessary, click the Type tab. This will display the Format Plot Dialog Type Tab.

3. When you have made all necessary changes, click OK or Apply to redraw the chart to reflect the 
new settings.

Related Topics:
Selecting a Chart Type 

Stacking on a Percent Axis  

DataPoints As Lines or Markers 



Selecting a Chart Type
The options grouped in the Chart section of the Format Plot Type Tab control the chart type and whether 
the chart is stacked.

You can stack series in a bar, line, area, step, combination, clustered bar, and horizontal bar chart. 
Stacking places the data points from the same category on top of each other. Each bar still represents the
same value. 

Stacking data shows how all categories in a series compare over time, or compares each part to the total.
The following illustration shows the stacked variations of several chart types. 

Related Topics:
The Format Plot Dialog 
Stacking on a Percent Axis  
DataPoints As Lines or Markers 



Stacking on a Percent Axis
When series data is stacked on a percent axis, all the values in each category are added together. That 
sum is considered 100 percent. Each data point in the category is drawn as a percentage of that sum. 
You can stack series by setting the option in the Type Tab of the Format Plot Dialog box.

The following illustration shows the same chart with regular stacking and stacking on a percent axis. 

Note       To display other types of percent stacking, change the scale of the charts Y axis. 
Related Topics:
The Format Plot Dialog 
Selecting a Chart Type 
DataPoints As Lines or Markers 



DataPoints As Lines or Markers
If your chart type is any 2D or 3D chart other than pie or bubble, you have the option to set datapoints as 
lines or markers. Markers and lines can both represent all data points on 2D line, XY, Radar, and Polar 
charts.

On the Format Plot Type Tab, to display lines, select the Lines check box.

To display markers, select the Markers check box.

To display both markers and lines, select both check boxes.

Related Topics:
The Format Plot Dialog 
Selecting a Chart Type 
Stacking on a Percent Axis  



Using Combination Charts
Combination charts allow you to plot each series differently on a chart. By depicting each series in its own
unique way, you increase the impact and readability of your chart.

When using combination charts, you must specify the type used to display each series in the chart. 

To change a series type:

1. Select a series in the Series Names list box on the Format Plot Type Tab. 

The Series Types list now shows the valid types for the selected series.

2. Select the type you want to use for the selected series. 

You can also select All Series to set the same type for all series in the chart.

Continue specifying types for each series as necessary. The following illustration shows the results of 
changing the Clothing series to a line chart and the Travel series to an area chart. 

Related Topics:
Using Radar Charts 
Using Hi-Lo Charts 



Using Radar Charts
Radar charts show changes or frequencies of each series relative to a center point and to one another. 
When you select Radar as the chart type, you can specify whether each series is displayed as a line or 
filled area.

To change the variation of a radar chart:

1. Select the 2D radio button to display a list of 2D chart types.

2. Select Radar in the Chart Type list box of the Format Plot Type Tab.

3. Select a series in the Series Name list.

4. Select a type for the series in the Series Type list.

Continue selecting types for additional series as necessary. The following illustration shows a radar chart 
with two series displayed as area and one series displayed as line.

Related Topics:
Using Combination Charts 
Using Hi-Lo Charts 



Using Hi-Lo Charts
If your chart depicts stock market information, or changes in data over a period of time, then a Hi-Lo Chart
is the best choice for plotting your data. When you select Hi-Lo as the chart type, you can specify the 
variation of hi-lo chart you want to display as well as assign different types to other series.

Related Topics:
Using Combination Charts 
Using Radar Charts 
Specifying Volume Information for Hi-Lo Charts 
Displaying Hi-Lo Bars In Other Chart Types 



Specifying Volume Information for Hi-Lo Charts
When you select Hi-Lo as the chart type, you can specify the variation of hi-lo chart you want to display as
well as assign different types to other series. The following tutorial tells you step-by-step how to set up a 
hi-lo chart to depict volume.

To specify a Hi-Lo-Close chart with Volume information:

1. Select the 2D radio button to display a list of 2D chart types from the Format Plot Type Tab.

2. Select Hi-Lo in the Chart Type list.

3. If a column in the data grid holds dates, select that series name and then select the Dates series 
type. 

This instructs First Impression to use the values in this column to create a date axis for this chart. 
The series is automatically excluded so that it is not actually charted.

4. Select the first series that holds stock information in Series Names list.

5. Select one of the Hi-Lo-Close variations in the Series Type list box.

The second and third column in every series are indented to show that the series requires three 
columns of data to chart a Hi-Lo-Close chart. 

6. Select the series that contains volume information in the Series Name list box.

7. Select the series type you want to use to display volume data. 

Bar, Line, or Area would be typical choices for displaying volume data. 

8. Click OK or Apply to redraw the chart.

Since volume information is usually very different from the high, low, and close price of stock you 
may need to take the following steps to finish the chart.

9. Double-click the Volume series in the chart; or, use the right mouse button to display the floating 
menu and select Series to display the Format Series dialog box.

If you use the menu, you must specify which series you want to format.

10. If necessary, click the Options tab.

11. Check the Plot on 2nd Y Axis check box. 

12. Click OK.

Note    You can display a date axis on a line or bar chart by selecting hi-lo as the chart type, specifying the
first series type as Date, and the remaining series as lines or bars.

Related Topics:

Using Hi-Lo Charts 

Displaying Hi-Lo Bars In Other Chart Types 



Displaying Hi-Lo Bars In Other Chart Types
You can use hi-lo bars to represent a range of values from a beginning point other than zero. Hi-lo bars 
are a series type available on bar, combination, horizontal bar, hi-lo and clustered bar charts. Each bar 
requires two columns from the data grid - a beginning value and an end value. The following illustration 
shows hi-lo bars in a chart.

Related Topics:
Using Hi-Lo Charts 
Specifying Volume Information for Hi-Lo Charts 



Reordering Series
You can change the order in which the series in a chart are displayed. This can be particularly useful if 
one series obscures the view of the data in another series. By rearranging the series, you can find the 
most aesthetically pleasing way to present your data. 

To reorder the series in a chart:

1. Double-click the chart plot; or, use the right mouse button to display the floating menu and select 
Plot.

2. Click the Order tab.

3. Select a series in the Series Order list box.

4. Click Up to move the series up in the drawing order. Click Down to move the series down in the 
drawing order. 

5. Click OK or Apply to redraw the chart.

Related Topics:

How Reordering Series Affects the Chart. 

Stacking Series 



How Reordering Series Affects the Chart
The results of reordering series in a chart can be quite effective in enhancing your display of data.

Simply changing the drawing order of series on a chart can make more data visible, and increase the 
impact your chart has.

The following illustrations show the result of moving the series labeled Europe in front of the series 
labeled Asia. 

You can also use buttons on the Order tab to stack and unstack series and to change the order of stacked
series. 

Related Topics:

Reordering Series 

Stacking Series 



Stacking Series
Stacking series in a chart can provide a better way of plotting similar data for multiple series. By stacking 
the data, you can illustrate changes and trends for multiple series together in one chart position. Stacking 
data can eliminate the obstructed views common to 3D charts.

To stack series in the Order tab:

1. Select the last series in the Series Order list box.

2. Click Stack.

The series you highlighted is shown as stacked with the preceding series.

3. Click Stack again.

The two stacked columns are now stacked with the preceding series. The order in which they appear in 
the stacked list is the order in which they are drawn, first series on the bottom of the stack. 

4. Click Apply to redraw the chart.
5. To unstack the series, select the Stack associated with the series in the Series Order list and click
Unstack.
Related Topics:

Reordering Series 

How Reordering Series Affects the Chart. 



Adding Chart Elements
In addition to the plot, the major chart elements are titles, legends, and footnotes. The following 
information explains how to add these elements to a chart.

To add a title to a chart:

1. Use the right mouse button to display the floating menu.

2. Select Title to display the Format Title dialog box.

3. Select the Location Tab if necessary.

4. Check the Visible check box to display the title.

5. Select the Text tab.

6. Type the title text in the Text field.

7. Click OK or Apply to redraw the chart to include the new title.

To add a legend to a chart:

1. Use the right mouse button to display the floating menu.

2. Select Legend to display the Format Legend dialog box.

3. Select the Location Tab if necessary.

4. Check the Visible check box to display the legend. 

By default, series labels are used to identify each series in the legend.

5. Click OK or Apply to redraw the chart to include the legend.

To add a footnote to a chart:

1. Use the right mouse button to display the floating menu.

3. Select Footnote to display the Format Footnote dialog box.

4. Select the Location Tab if necessary.

5. Check the Visible check box to display the footnote.

6. Select the Text tab.

7. Type the footnote text in the Text field.

8. Click OK or Apply to redraw the chart to include the new footnote. 

Related Topics:
Controlling the Display of Chart Elements 

Automatic Chart Layout 

Chart Element Areas 

Positioning Chart Elements 



Repositioning Chart Elements

Custom Chart Element Positions 

Effect of Element Positioning on the Chart 



Controlling the Display of Chart Elements
First Impression provides a quick and easy way to turn off or on the display of existing chart elements 
such as the title, the legend, the footnote, and the second Y axis. 

To hide or show a title, footnote, legend, or second Y axis:

1. Click the right mouse button to display the floating menu.

2. Select General to display the Format Chart dialog box with the Options tab selected.

3 Check the Show Title, Show Footnote, Show Legend, or Show 2nd Y Axis check box to display any
of those elements. Uncheck those items to hide any of those elements.

Note      If you have not created a title or footnote, checking the Show Title or Show Footnote check box 
displays default text.

4. Click OK or Apply to redraw the chart.

Related Topics:
Adding Chart Elements 

Automatic Chart Layout 

Chart Element Areas 

Positioning Chart Elements 

Repositioning Chart Elements

Custom Chart Element Positions 

Effect of Element Positioning on the Chart 



Automatic Chart Layout
By default, First Impression operates in automatic layout mode. As you add elements such as a title or 
legend to a chart, the existing chart elements are resized and repositioned to make room for the new 
elements. For example, the following illustration shows how a chart plot is resized when you add a title to 
the chart. 

Related Topics:
Adding Chart Elements 

Controlling the Display of Chart Elements 

Chart Element Areas 

Positioning Chart Elements 

Repositioning Chart Elements

Custom Chart Element Positions 

Effect of Element Positioning on the Chart 



Chart Element Areas
In automatic layout, the chart plot, title, legend, and footnote are all drawn within their individual areas of 
the chart. The size of text used for the title, legend, footnote, and the axis labels and titles determines the 
size of each area. If you use very large fonts or long text, elements may be cropped and the axis labels 
and titles may be dropped from the plot. The following illustration shows each element in its default 
position and shows an example of how the chart area is divided for each element. 

Related Topics:
Adding Chart Elements 

Controlling the Display of Chart Elements 

Automatic Chart Layout 

Positioning Chart Elements 

Repositioning Chart Elements

Custom Chart Element Positions 

Effect of Element Positioning on the Chart 



Positioning Chart Elements
By default, when you add a title, legend, or footnote, First Impression puts the object in a specific location.
The following illustration shows the default position for each of these objects.

The following illustration defines the nine preset locations First Impression uses for placing objects. 

Related Topics:
Adding Chart Elements 

Controlling the Display of Chart Elements 

Automatic Chart Layout 

Chart Element Areas 



Repositioning Chart Elements

Custom Chart Element Positions 

Effect of Element Positioning on the Chart 



Repositioning Chart Elements
First Impression makes it easy to relocate chart elements using the Location tab of the element dialog 
box.

To move a chart element to a new predefined position:

1. Double-click an element (the footnote, for example) to display the appropriate dialog box.

2. Select the Location tab.

3. Select one of the position radio buttons and click OK or Apply.

See Custom Chart Element Positions for more information on custom chart element locations.

Related Topics:
Adding Chart Elements 

Controlling the Display of Chart Elements 

Automatic Chart Layout 

Chart Element Areas 

Positioning Chart Elements 

Effect of Element Positioning on the Chart 



Custom Chart Element Positions
You can override the size and layout of chart elements by selecting and dragging elements on the screen 
or by making settings in a dialog box. 

To resize or reposition objects manually:

1. Select the title, footnote, plot, or legend.

2. Once the object is surrounded by selection handles, you can drag it to a new location or resize it 
as desired.

Bear in mind that what you are actually resizing is not the text or plot itself, but the bounding 
rectangle around the object. Based on the size you make the object, First Impression may have to 
resize or clip objects to fit the space.

To resize or reposition objects using dialog box settings:

1. Double-click the title, footnote, plot, or legend.

The appropriate dialog box is displayed.

2. Select the Location tab.

3. Select the Custom radio button.

4. Enter values in the Top, Left, Height, and Width fields to describe the coordinates of the upper left 
corner of the object and its height and width.

First Impression uses the measurement unit specified in your Windows default settings. 

Related Topics:
Adding Chart Elements 

Controlling the Display of Chart Elements 

Automatic Chart Layout 

Chart Element Areas 

Positioning Chart Elements 

Repositioning Chart Elements 

Custom Chart Element Positions 

Effect of Element Positioning on the Chart 



Effect of Element Positioning on the Chart
The following illustration shows the results of resizing and repositioning chart elements.

{bmc U5CUSLAY.BMP}

Related Topics:
Adding Chart Elements 

Controlling the Display of Chart Elements 

Automatic Chart Layout 

Chart Element Areas 

Positioning Chart Elements 

Repositioning Chart Elements

Custom Chart Element Positions 



Optimizing Chart Text
You can optimize the appearance of all chart text for display on the screen or for appearance in a printed 
chart.

To optimize chart text:

1. Click the right mouse button to display the floating menu.

2. Select General from the floating menu to display the Format Chart dialog box.

3. Select Options to display the Options Tab.

4. Select one of the text metric radio buttons.

Related Topics:
Formatting Fonts 

Aligning and Orienting Text 



Formatting Fonts
You can specify the font, font style, font size, font color, and special effects used to display a text element 
on a chart.

To format text:

1. Double-click the left mouse button on the text you want to format. 

You can also use the right mouse button to display the floating menu and select the appropriate 
item for the chart element you are formatting. 

The appropriate dialog box is displayed with the Font or Backdrop tab selected. 

2. Select the Font tab.

The dialog box tabs used to format fonts for the chart titles, legends, footnotes, and axis titles are all the 
same. 

Related Topics:
Optimizing Chart Text 

Aligning and Orienting Text 



Aligning and Orienting Text
You can also control the justification, orientation, and alignment of chart text. The horizontal and vertical 
alignment of text is only observed if you enlarge the rectangle holding the text. 

Alignment and orientation of text is managed through the Text Tab.

Many different dialogs contain a Text tab. Some of the dialogs that contain a text tab include: The Format 
Title, Format Axis Label, and Format Series Label.

The following tables define the orientation and text alignment options available for your chart text. For 
more information about how to set these options, refer to the Text Tab.

Horizontal alignment options for text. 

Alignment Description
Left All lines of text are aligned on the left margin.

Right All lines of text are aligned on the right margin.

Center All lines of text are centered horizontally.

Vertical alignment options for text.

Alignment Description
Top All lines of text are aligned at the top margin.

Bottom All lines of text are aligned at the bottom margin.

Center All lines of text are centered vertically.

Orientation options for text.

Orientation Description
Horizontal The text is displayed horizontally.

Vertical The text is displayed, one letter on top of each other, reading from 
top to bottom.

Up The text is rotated to read from bottom to top.

Down The text is rotated to read from top to bottom.

Note       When you rotate text up or down, the vertical and horizontal alignment are still relative to the text 
and not to the bounding box. In other words, text displayed with up orientation and left alignment is 
actually flush against the bottom of the bounding box, not the left side.

Related Topics:
Optimizing Chart Text 

Formatting Fonts 



Assigning Backdrops to Elements
You can enhance a charts appearance by placing a backdrop on the chart itself, and on individual chart 
elements. A backdrop can include a frame or box around the chart or chart element, a shadow behind the 
element, and a pattern, gradient, or graphic picture behind the element.

The following illustration shows the various chart elements that can be assigned a backdrop.

Related Topics:
Editing Backdrops 

Backdrop Fills 

Picture Fit Methods 

Resetting To Default Formats 



Editing Backdrops
Once you have determined to use a backdrop for your chart element, you may need to edit the backdrop 
in order to achieve the desired results. Many First Impression dialogs include a Backdrop tab which 
contains several options for modifying backdrops.

To edit a backdrop:

1. Double-click the left mouse button on the chart element whose backdrop you want to edit. 

You can also use the right mouse button to display the floating menu and select the appropriate 
command for the chart element you are formatting. 

2. Once the appropriate dialog box is displayed, select the Backdrop Tab if necessary. 

The dialog box tabs used to format the backdrops for the chart control, chart plot, title, legend, 
labels, series labels, data point labels, and footnotes are all the same. 

3. When you have finished making any necessary changes to the backdrop, click OK or Apply to 
redraw the chart to reflect the changes.

Related Topics:
Assigning Backdrops to Elements 

Backdrop Fills 

Picture Fit Methods 

Resetting To Default Formats 



Backdrop Fills
You can choose among a number of types of backdrop fill. The following illustration shows examples of 
several fill types.

The controls in the Fill section of the Backdrop tab allow you to set the fill type, color, and pattern.

Pattern Backdrop Fills
One or two colors are used to display a pattern in the chart control or chart element. 

Patterns are bitmaps. A low resolution version of each bitmap displays the pattern on the screen. When 
you print a chart, a high resolution version of the bitmap is used if the output device prints at more than 
144 dpi. The higher the resolution of the output device, the smaller the copies of the bitmaps that make up
the patterns are reproduced. At high resolutions, First Impression adjusts the patterns to prevent the lines 
from getting too close together. Hatches are not bitmaps, but actual lines drawn to fill the object. They 
always appear the same regardless of the output resolution. Hatches can be used to output First 
Impression charts on a plotter. 

The following illustration shows which patterns in the pattern popup are bitmaps and which are hatches.

Gradient Backdrop Fills
A gradient blends two colors to create the fill. The colors can be blended from top to bottom, left to right, 



in concentric rectangles, or concentric ovals. 

The following illustration shows examples of the various types of gradients.

Picture Fills
Picture Fills allow you to specify a graphic image to use as the backdrop fill. You can use a picture fill on a
chart element regardless of its pattern or gradient setting. If the graphic does not cover the entire 
backdrop area, any specified pattern or gradient covers the remaining area. 

Note       If you use a Windows metafile for the graphic, it does not show up if you use the copy command 
to copy the chart to the clipboard. Windows limits you from having a metafile that contains a metafile. If 
you plan to copy the chart to the clipboard, use a bitmap for the graphic instead of a metafile.

Some graphics products output bitmap files in an older format that is compatible with OS/2. First 
Impression does not support these bitmaps. If you attempt to use one of these files, you receive an error, 
"Invalid picture format." You can read these files into PaintBrush and save them as BMPs to convert them 
to the newer bitmap format. First Impression can then use these files without any problems.

Related Topics:
Assigning Backdrops to Elements 

Editing Backdrops 

Picture Fit Methods 

Resetting To Default Formats 



Picture Fit Methods
There are a number of ways to fit a picture behind a chart as a backdrop.The following table lists the 
options for fitting graphics.

Constant Description
Actual Size Displays the graphic at the original size it was created. If the original size of the graphic is too

large, the graphic is cropped. If the original size of the graphic is too small, it is centered.

Best Fit Scales the graphic proportionally to fit entirely within the backdrop.

Stretch to Fit Scales the graphic to fit backdrop regardless of its original proportions.

Tiled Duplicates the graphic repeatedly to fill the backdrop.

Crop Fitted Centers the graphic and scales it proportionally to fill the backdrop. Any part of the image that
falls outside the backdrop is cropped.

The following illustration shows each of these options.

Related Topics:
Assigning Backdrops to Elements 

Editing Backdrops 



Backdrop Fills 

Resetting To Default Formats 



Resetting To Default Formats
You can reset a chart to the First Impression default formats. All chart options, except the chart type are 
returned to their default values.

To reset the chart:

1. Click the right mouse button to display the floating menu.

2. Select General to display the Format Chart dialog box with the Options tab selected.

3. Click the Reset button.

4. Click OK or Apply to redraw the chart.

Related Topics:
Adding Chart Elements 

Controlling the Display of Chart Elements 

Automatic Chart Layout 

Chart Element Areas 

Positioning Chart Elements 

Repositioning Chart Elements

Custom Chart Element Positions 

Effect of Element Positioning on the Chart 

Optimizing Chart Text 

Formatting Fonts 

Aligning and Orienting Text 

Assigning Backdrops to Elements 

Editing Backdrops 

Backdrop Fills 

Picture Fit Methods 



Formatting 3D Charts
There are a number of items you can format that are unique to 3D charts. These include:

The rotation and elevation from which the chart is viewed.
The viewing distance used to display the chart.
The proportions of the chart.
The type of projection used to draw the chart.
The lighting of 3D elements.
The appearance of the base and wall of the chart.

Related Topics:

Changing Chart Rotation and Elevation 

Chart Elevation Options 

Chart Rotation Options 

Chart Projection 

Chart Width and Height Ratios 

Chart Viewing Distance 

Formatting the Base and Walls 

Lighting 3D Charts 

Ambient Lighting 

Infinite Light Sources 



Changing Chart Rotation and Elevation
You can change the rotation, elevation, viewing distance, and proportions of a 3D chart using settings on 
the 3D View tab of the Format Plot dialog box. You can also change the rotation and elevation of a chart 
interactively.

To change the 3D view using the Format Plot 3D View Tab:

1. Double-click the chart plot; or, click the right mouse to display the floating menu and select Plot.

2. Click the 3D View tab.

3. Make any necessary changes and click OK or Apply to redraw the chart reflecting the changes.

To change the rotation and elevation of a chart interactively:

1. Place the pointer anywhere in the chart region.

2. Press and hold the CTRL key.

The cursor changes to the rotation cursor.

3. Click and hold the left mouse button.

A dotted bounding box appears around the chart plot. Reference arrows appear at the corner 
where the first data point in the first series is drawn.

4. Move the pointer up and down to change the chart elevation and right and left to change the chart 
rotation.

The bounding box shows the position of the chart plot as you move the mouse.

5. When you find the rotation and elevation you want, release the mouse button.

The chart repaints in the new position.

Related Topics:

Chart Elevation Options 

Chart Rotation Options 



Chart Elevation Options
An important aspect of changing the 3D view is altering the elevation at which the chart is viewed. 
Elevation is defined as the relative height from which a chart is viewed. An Elevation height of 90 
positions the chart as if you are looking directly down on the top of the chart. An elevation of 0 positions 
the chart as if you are looking directly at the side of the chart. The default elevation is 30 degrees. For 
specific information on how to modify the elevation of a 3D chart, see the Format Plot 3D View Tab. The 
following illustration shows a 3D chart at two different elevation levels.

Related Topics:

Changing Chart Rotation and Elevation 

Chart Rotation Options 



Chart Rotation Options
Another option for changing the 3D view includes altering the rotation of a chart.

Rotation is defined as the angle that the chart is turned from the viewer. Rotation does not apply to 3D pie
or doughnut charts. For specific information on how to modify the rotation of a chart, see The Format Plot 
3D View Tab. The following illustration shows a 3D chart at two different degrees of rotation.

Changing Chart Rotation and Elevation 
Chart Elevation Options 



Chart Projection
When you look at a 3D chart on a computer screen or a printed piece of paper, you are looking at an 
object that is specially drawn to give a 3D appearance in a 2D plane. Projection is a mathematical 
process used to display a 3D chart in a 2D plane. The following table describes the various types of 
projection. 

Projection Description
Oblique This is sometimes referred to as 2.5 dimensional. The chart has depth, but the XY plane does not change 

when the chart is rotated or elevated.

Orthogonal Perspective is not applied to the chart. The advantage of using this type of projection is that vertical lines 
remain vertical, making some charts easier to read.

Perspective This provides the most realistic 3D appearance. Objects farther away from you converge toward a vanishing
point.

For specific information on how to alter chart projection, see The Format Plot 3D View Tab.

Important      Surface charts will not display with oblique projection. If the Oblique projection type is 
selected for a surface chart, an orthogonal projection will be substituted instead.

The following illustration shows the same chart drawn using different projection methods.

Related Topics:
Changing Chart Rotation and Elevation 
Chart Elevation Options 
Chart Rotation Options 



Chart Width and Height Ratios
Depending on the type of chart you are displaying, you may desire to alter the width and depth of the 
chart in order display data more efficiently. You can modify how the chart's width and depth is drawn 
according to the charts height. This is known as the width to height ratio and depth to height ratio. The 
ratio is calculated according to the percentage of the chart's height used to draw the charts width and 
depth. For specific information on how to modify this value, see the Format Plot 3D View Tab.

The following illustration shows various degrees of width and depth ratios to display the chart.

Related Topics:
Chart Projection 
Chart Viewing Distance 



Chart Viewing Distance
The perspective of an object changes as you move closer to it or farther away from it. The same is true of 
a 3D chart. The Viewing Distance is defined as the distance from which the chart is viewed as a 
percentage of the dpth of the chart. For specific information on how to modify the viewing perspective for 
a chart, see The Format Plot 3D View Tab.

By default, 3D charts are viewed from a distance of 200 percent of the chart's depth. The following 
illustration shows the same chart at two different viewing distances.

Related Topics:
Chart Projection 
Chart Width and Height Ratios



Formatting the Base and Walls
You can change the colors and patterns applied to the walls of a 2D chart and the walls and base of a 3D 
chart, the color used to draw the lines in the base and walls, the height of the base, and the width of the 
walls. The width of the walls and height of the base are measured in points. 

To format the walls and base:

1. Double-click in the chart plot; or, use the right mouse button to display the floating menu and select
Plot. 

2. Select the Base and Walls tab.

3. Make any necessary changes and click OK or Apply to redraw the chart to reflect the changes.

Note:      One of the options you can choose for a chart base or wall is to display the base or wall as a 
pattern. It is important to understand how patterns work before using them in your chart.

Patterns are bitmaps. A low resolution version of each bitmap displays the pattern on the screen. When 
you print a chart, a high resolution version of the bitmap is used if the output device prints at more than 
144 dpi. The higher the resolution of the output device, the smaller the copies of the bitmaps that form the
patterns are reproduced. At high resolutions, First Impression adjusts the patterns to prevent the lines 
from getting too close together. Hatches are not bitmaps, but actual lines drawn to fill the object. They are 
always drawn at the same resolution, regardless of the output device. Hatches can be used to output First
Impression charts on a plotter. 

Related Topics:

Formatting 3D Charts 

Changing Chart Rotation and Elevation 



Lighting 3D Charts
When light falls on a 3D object some areas of the object are brightly illuminated, and other areas are in 
shadows. You have complete control of how much light strikes the chart, and from what direction. 

To change the lighting on a 3D chart:

1. Double-click the chart plot; or, click the right mouse button to display the floating menu and select 
Plot.

2. Select the 3D Lighting tab.

3. Make any necessary changes and click OK or Apply to redraw the chart to reflect the changes.

Related Topics:

Ambient Lighting 

Infinite Light Sources 



Ambient Lighting
Ambient light is defined as the diffusive light that shines on all sides of chart elements and is cast in 
addition to light from fixed light sources. If ambient light is set to 100 percent, all sides of the chart 
elements are illuminated equally no matter what light sources you turn on. If ambient light is set to 0, only 
the sides of chart elements facing the active light sources are illuminated. The default setting for ambient 
light is 15 percent.

For more information about how to set ambient lighting, see The Format Plot 3D Lighting Tab.

The following illustration shows the varying degrees of ambient light on a chart.

Edge Intensity is defined as    the amount of lighting applied to the edges of 3D objects such as bars, 
lines, pies or doughnuts. An edge light intensity of 0 draws the edges as black lines. An edge light 
intensity of 100 percent fully illuminates the edges using the edge pens color. The default edge pen color 
is the same as the series fill color. 
The following illustration depicts varying degrees of edge lighting on a chart.

Related Topics:
Lighting 3D Charts 



Infinite Light Sources 



Infinite Light Sources
You can "turn on" or "turn off" up to nine preset infinite light sources on your chart. An infinite light source 
means that while there is a direction towards which the light shines, there is not a fixed distance from 
which the light is shone. The position of the light source is at infinity with reference to the chart. This 
allows a more uniform illumination and shading of the chart surfaces.    At an intensity of 100 percent, 
chart surfaces perpendicular to the light source are fully illuminated. At an intensity of 50 percent, these 
surfaces receive 50 percent illumination from this light. An intensity of 0 turns off the light source. For 
specific information on how to set infinite light sources, see the Format Plot 3D Lighting Tab.

Important         A chart surface's total illumination is the sum of the contributions of the ambient light and 
each of the infinite lights.
Related Topics:

Lighting 3D Charts 

Ambient Lighting 



Formatting Axes
There are a number of axis components that you can format on a 2D or 3D chart. You can:

Change the axis type.
Format date axes.
Change the color and size of the axis grid lines.
Change the color and size of axis lines.
Change the color and size of the axis tick lines.
Change the scale of the axis.
Create and format an axis title.
Format axis labels.

Related Topics:

Axis Terminology 

Common Axis Elements 



Axis Terminology
There are three types of axes that can appear on a chart: a value axis, a category axis, and a date axis. 
Category axes have text labels identifying the category or series in the chart. Value axes display numbers
as values or percents. Date axes display a range of dates. It is important to know the type of axis you are 
dealing with in each chart type, because any appropriate formatting applied to an axis is maintained when
you switch to a new chart type. 

The following table provides a list of the types of each axis on various chart types.

Chart Types X Y 2nd Y Z
2D Bar Category Value Value N/A

2D Line

2D Area

2D Step

2D Combination

3D Bar Category Value Value Category

3D Line

3D Area

3D Step

3D Combination

2D and 3D Horizontal Bar Category Value N/A N/A

2D and 3D Gantt Category Date N/A N/A

XY Value Value N/A N/A

Bubble Value Value N/A N/A

Hi-Lo Date or Category Value Value N/A

Polar Angle Value N/A N/A

Radar Radar Value N/A N/A

3D Clustered Bar Category Value Value N/A

3D XYZ Value Value Value N/A

3D Scatter Value Value Value Value

2D Contour Category N/A N/A Category

3D Surface Category Value Value Category
Related Topics:

Formatting Axes 

Common Axis Elements 



Common Axis Elements
The axes that appear on a chart vary from one chart type to another. The following illustration shows the 
common features of axes on 2D and 3D bar, line, area, and step charts.

Related Topics:
Formatting Axes 
Axis Terminology 



Gantt and Horizontal Bar Charts
Both gantt and horizontal bar charts display the category (X) axis vertically along the left side of the chart. 
Gantt charts display the date (Y) axis along the bottom of the chart. Horizontal bar charts display the 
value (Y) axis along the bottom of the chart.    

Related Topics:
Formatting Axes 
Axis Terminology 
Common Axis Elements 
Radar and Polar Charts 



Radar and Polar Charts
The axis elements on radar and polar charts are slightly different. The following illustration shows the axis
elements displayed on these two types. 

Note       Pie and doughnut charts have no axis information, but use the format settings for X axis labels to
format the labels on an individual pie or doughnut chart.
Related Topics:
Formatting Axes 
Axis Terminology 
Common Axis Elements 
Gantt and Horizontal Bar Charts 



How to Format an Axis
The following discussion provides information for formatting all types of axes.

To format an axis:

1. Double-click the axis or use the right mouse button to display the floating menu and select Axis.

If you use the menu, you must specify which axis you want to format. The Format Axis dialog box 
is displayed.

The following table briefly describes each tab in the Format Axis dialog box.

Tab Description
Options Controls the line width and color used to draw the axis line and tick marks.

Grid Controls the color, line style, and line thickness used to display the major and minor grid lines.

Scale Controls the display of the axis, type and settings of the axis scale. The options on this tab vary depending 
on the type of axis selected: category axis, date axis or value axis.

Ticks Controls the length and positioning of ticks on the axis line.

2. Make any necessary changes to any axis options and click OK or Apply to redraw the chart.

Related Topics:

Formatting Axes 

Axis Terminology 

Common Axis Elements 

Gantt and Horizontal Bar Charts 

Radar and Polar Charts 

Labeling Axis Tick Marks 

Labeling Axes Inside The Plot 

Displaying Axes Scales 

Automatic and Manual Scaling 



Labeling Axis Tick Marks
Axis labels contain tick marks that signify the divisions along a chart axis. These labels can occur at major
and minor divisions on a chart. Depending on the chart size, labeling tick marks at every division can 
sometimes result in a cluttered, hard-to-read chart. Skipping labels and tick marks can help reduce the 
clutter of labels that can occur when you have a large number of divisions. For specific information about 
labeling tick marks and how to skip them to avoid clutter, see the Format Axis Ticks Tab.

The following illustration demonstrates the use of this option.

Related Topics:
Formatting Axes 
Axis Terminology 
Common Axis Elements 
Gantt and Horizontal Bar Charts 
Radar and Polar Charts 
How to Format an Axis 
Labeling Axes Inside The Plot 
Displaying Axes Scales 

Automatic and Manual Scaling 



Labeling Axes Inside The Plot
If a chart moves the axis intersection to a point well within the chart plot, it may be difficult to read the 
labels from their location along the original axis. First Impression provides you the option of labeling the 
axis at its new location to improve label readability. For information about how to label the axis inside the 
plot, see The Format Axis Scale Tab. 

The following illustration shows axis labeling on the original axis and inside the plot.

Related Topics:
Formatting Axes 
Axis Terminology 
Common Axis Elements 
Gantt and Horizontal Bar Charts 
Radar and Polar Charts 
How to Format an Axis 
Labeling Axis Tick Marks 
Displaying Axes Scales 
Automatic and Manual Scaling 



Displaying Axes Scales
For aesthetic reasons, you may not wish to display all the axis scales for a chart. First Impression 
provides you the methods to turn on and turn off axis scales when displaying a chart. Each time you 
display the Format Axis dialog box, you must first choose the axis type. 

The Format Axis Scale tab will appear differently depending on the type of axis you have chosen. For 
specific information on how turn on and off category axis scales see The Format (Category) Axis Scale 
Tab. 

For specific information on how turn on and off value axis scales see The Format (Value) Axis Scale Tab

The following illustration shows the same chart, first with the X axis scale on, and then with the X axis 
scale turned off.

The following illustration shows a chart with the Y axis scale turned off.

Related Topics:
Formatting Axes 
Axis Terminology 
Common Axis Elements 
Gantt and Horizontal Bar Charts 

Radar and Polar Charts 

How to Format an Axis 

Labeling Axis Tick Marks 

Labeling Axes Inside The Plot 



Automatic and Manual Scaling 



Automatic and Manual Scaling
If a chart is set to automatic scaling, the axis scale will display the minimum and maximum values as well 
as all the values in between. Your chart may look better if you limit the scale values that display by setting 
your own manual scale values. For specific information on how to set Automatic or Manual scaling, see 
The Format (Value) Axis Scale Tab.

The following illustration shows the same chart, first with automatic scaling, and then with manual scaling.

Related Topics:
Formatting Axes 
Axis Terminology 
Common Axis Elements 
Gantt and Horizontal Bar Charts 
Radar and Polar Charts 
How to Format an Axis 
Labeling Axis Tick Marks 
Labeling Axes Inside The Plot 
Displaying Axes Scales 



3D Axis Intersections
If the current chart is a 3D XYZ chart, then the Format Axis Scale tab displays options for placement of 
the axes intersections. You may wish to allow the axes to intersect at their usual positions, or you may 
want to enable the Cross At option to specify where you want the current axis to cross the intersecting 
axis. The Format Axis Scale Tab provides individual options for placing the X, Y, and Z axis.

Related Topics:

Displaying Axes Scales 

Automatic and Manual Scaling 

Date Axis Scaling 

Radar Axis Scaling 

Polar Axis Scaling 

Formatting Axis Ticks 



Date Axis Scaling
If you select a date axis on your chart, the Format Axis Scale tab displays options for showing the axis 
scale and entering the values used to scale the date axis. The values you are allowed to specify include 
the beginning date for the axis, the ending date for the axis, and intervals to pass between tick marks. 

Major Interval Tick Mark Settings

The major ticks and grid lines appear at major intervals, and the minor ticks and grid lines appear at minor
intervals. Axis labels are drawn at major intervals. The following table describes the settings for these 
options.

Type Description
None No Interval.

Days A tick mark occurs each day.

Weeks A tick mark occurs Monday of each week.

Semi-months A tick mark occurs on the 1st and 15th day of each month.

Months A tick mark occurs on the 1st of each month.

Years A tick mark occurs on January 1 of each year.

For example, to create a quarterly scale, set the interval to 3 months.

For specific information about how to set these options, see The Format (Date) Axis Scale Tab.

The following illustration shows the use of the Major Format, New Month, and New Year options.

Note       First Impression displays dates in this tab using the Windows environment date format assigned 
though the Control Panel. A confusing situation can occur when using dates earlier than 1920. If you have
your date format set to not show centuries, the scale tab assumes the date displayed is between 1/1/1920
and 12/31/2019. So, if you have a date axis minimum of Jan 1, 1905, displayed as 1/1/05, the dialog will 
convert it to Jan 1, 2005. The solution is to use centuries in your Windows date format if you want to deal 
with dates outside the range 1/1/1920 to 12/31/2019.
Related Topics:



Displaying Axes Scales 

Automatic and Manual Scaling 

3D Axis Intersections 

Radar Axis Scaling 

Polar Axis Scaling 



Radar Axis Scaling
The only scaling change you can make for a radar axis is to turn the display of the axis on or off. The 
value axes on a radar chart can be formatted like any other value axis. For specific information on how to 
turn the axis display on or off for a radar chart, see The Format (Radar) Axis Scale Tab.

Related Topics:

Displaying Axes Scales 

Automatic and Manual Scaling 

3D Axis Intersections 

Date Axis Scaling 

Polar Axis Scaling 



Polar Axis Scaling
The radius axis on a polar chart can be formatted just like any other value axis. Scaling the polar axis 
allows you to control the number of radial grid lines and labels that are displayed around the perimeter of 
the chart. Radial grid lines for major divisions extend to the center of the chart. Radial grid lines for minor 
divisions extend from the first division of the value axis to the perimeter of the chart. For specific 
information about formatting the radius axis, see the Format (Polar) Axis Scale Tab.

Related Topics:
Displaying Axes Scales 
Automatic and Manual Scaling 
3D Axis Intersections 
Date Axis Scaling 
Radar Axis Scaling 



Formatting Axis Ticks
You can modify the tick marks that appear on your chart axes. The length of major tick marks can be 
modified to best fit the chart. Tick mark position on the axis can also be modified. The following table lists 
the available tick position settings. 

Style Description
None No tick marks are displayed on the axis. 

Center Tick marks are centered across the axis.

Inside Tick marks are displayed inside the axis.

Outside Tick marks are displayed outside the axis.

For specific information about these tick mark settings, see The Format Axis Ticks tab.

Related Topics:

Formatting Axes 

Axis Terminology 

Common Axis Elements 

Labeling Axis Tick Marks 



Formatting Axis Labels
You can change the font, font size, orientation, and alignment of axis label text, use a mask to format the 
text, and create a backdrop for the label. Labels on individual pie charts are actually x axis labels. To 
format pie chart labels, format the x axis labels on a chart.

The following illustration shows how multiple levels of labels are displayed on two different types of 
charts.

To format a set of axis labels:

1. Double-click on one of the labels you want to format; or, select Axis in the Labels menu to display 
the Format Axis Labels dialog box.

Related Topics:

Formatting Axes 

Axis Terminology 

Common Axis Elements 

How to Format an Axis 

Formatting Axis Ticks 

Format Axis Labels Dialog 

Controlling Label Position

Standing Labels 

Axis Label Text Formatting 





Format Axis Labels Dialog
If you use the menu, the following dialog box appears. Specify which axis and level of labels you want to 
format.

The following table describes each of the tabs on the Format Axis Labels dialog box
Tab Description
Backdrop Controls the fill, frame, and shadow used to create a backdrop for the axis label. 

Text Controls the orientation and alignment of the axis labels.

Font Controls the font, font size, font color, font style, and special effects used to display the 
axis label text. 

Format Code Controls the mask used to display the axis labels.

Related Topics:

Formatting Axes 

Axis Terminology 

Common Axis Elements 

Labeling Axes Inside The Plot 

Formatting Axis Labels 

Controlling Label Position 

Standing Labels 

Axis Label Text Formatting 



Controlling Label Position
The Text Tab of the Format Axis Label dialog box provides the methods needed to control axis label 
position for your chart. 

The Horizontal, Vertical, and Orientation sections of the dialog box are enabled if you uncheck the 
Automatic check box. The horizontal and vertical alignment refer to how the text is aligned within each 
division.

Horizontal Alignment. The following table describes the horizontal alignment options for label text. 

Alignment Description
Left Each label is aligned at the left edge of the division.

Right Each label is aligned at the right edge of the division.

Center Each label is centered horizontally within the division.

Vertical Alignment. The following table describes the vertical alignment options for label text.

Alignment Description
Top Each label is aligned at the top of the division.

Bottom Each label is aligned at the bottom of the division.

Center Each label is centered vertically within the division.

Orientation. The following table describes the orientation options for label text.

Orientation Description
Horizontal The text is displayed horizontally along the direction of the axis.

Vertical The text is displayed, one letter stacked on top of each other, reading from top to bottom.

Up The text is rotated so its right edge is next to the axis.

Down The text is rotated so its left edge is next to the axis.

Note       When you rotate text up or down, the vertical and horizontal alignment are still relative to the text 
and not to the chart. In other words, text displayed with up orientation and right alignment is actually flush 
against the axis, not the left side of the division.

Related Topics:

Formatting Axis Labels 

Format Axis Labels Dialog 

Standing Labels 

Axis Label Text Formatting 



Standing Labels
On 3D charts, you may desire to rotate labels up on the text baseline to stand in the Y plane. Standing 
text can make the labels more legible if you are viewing the chart at very low elevations. This option 
applies only to labels on an X or Z axis on most charts, and the Y axis on horizontal charts.

Related Topics:
Formatting Axis Labels 
Format Axis Labels Dialog 
Controlling Label Position 
Axis Label Text Formatting 



Axis Label Text Formatting
The Format Code Tab of the Format Axis Label dialog box provides options for formatting axis label text. 
You can select the format string category and the format code from a list of    predefined strings. For 
details on how to format axis label text, see the Axis Label Format Code Tab.

Click here to view sample Number Formats.

Click here to view sample Date and Time Formats.

Click here to view the codes available to use when designing Custom Label Formats.

Related Topics:

Format Axis Labels Dialog 

Controlling Label Position 

Standing Labels 



Number Formats
The following table lists the built-in number formats and the results if the format is applied to a positive, 
negative, and decimal number. 

Category Format 3 -3 .3
All General 3 -3 .3

Fixed 0 3 -3 0

0.00 3.00 -3.00 0.30

#,##0 3 -3 0

#,##0.00 3.00 -3.00 0.30

#,##0_);(#,##0) 3 (3) 0

#,##0_);[RED](#,##0) 3 (3) in red 0

#,##0.00_);(#,##0.00) 3.00 (3.00) 0.30

#,##0.00_);[RED](#,##0.00) 3.00 (3.00) in red 0.30

Currency $#,##0_);($#,##0) $3 ($3) $0

$#,##0_);[RED]($#,##0) $3 ($3) in red $0

$#,##0.00_);($#,##0.00) $3.00 ($3.00) $0.30

$#,##0.00_);[RED]$(#,##0.00) $3.00 ($3.00) in red $0.30

Percentage 0% 300% -300% 30%

0.0% 300.0% -300.0% 30.0%

0.00% 300.00% -300.00% 30.00%

Fraction # ?/? 3 -3 2/7

# ??/?? 3 -3 3/10

Scientific 0.00E+00 3.00E+00 -3.00E+00 3.00E-01

##0.0E+0 3.0E+0 -3.0E+0 3.0E-01

Date and Time Formats
The following table lists the built-in date and time formats and the result of applying the format.

Category Format Result
Date m/d/y 2/3/94

d-mmm-yy 3-Feb-94

d-mmm 3-Feb

mmm-yy Feb 94

m/d/y h:mm 2/3/94 6:15

Time h:mm AM/PM 3:29 PM

h:mm:ss AM/PM 3:29:41 PM

h:mm 15:29



h:mm:ss 15:29:41

mm:ss 29:41

[h]:mm:ss 1:09:33

Custom Label Formats
The following table lists the format symbols that can be used in a custom format string. Any symbol used 
to create a custom format string that exactly matches another format symbol will be parsed as an 
escaped character. (i.e. \m).

Format Symbol Description
General Displays the number in General format.

0 Digit placeholder. If the number contains fewer digits than the format contains placeholders, the number is padded with 0's.
If there are more digits to the right of the decimal than there are placeholders, the decimal portion is rounded to the 
number of places specified by the placeholders. If there are more digits to the left of the decimal than there are 
placeholders, the extra digits are retained.

# Digit placeholder. This placeholder functions the same as the 0 placeholder except the number is not padded with 0's if the
number contains fewer digits than the format contains placeholders.

? Digit placeholder. This placeholder functions the same as the 0 placeholder except that spaces are used to pad the digits.

. (period) Decimal point. Determines how many digits (0's or #'s) are displayed on either side of the decimal point. If the format 
contains only #'s left of the decimal point, numbers less than 1 begin with a decimal point. If the format contains 0s left of 
the decimal point, numbers less than 1 begin with a 0 left of the decimal point.

% Displays the number as a percentage. The number is multiplied by 100 and the % character is appended.

, (comma) Thousands separator. If the format contains commas separated by #'s or 0's, the number is displayed with commas 
separating thousands. A comma following a placeholder scales the number by a thousand. For example, the format 0, 
scales the number by 1000 (e.g., 10,000 would be displayed as 10).

E- E+ e- e+ Displays the number as scientific notation. If the format contains a scientific notation symbol to the left of a 0 or # 
placeholder, the number is displayed in scientific notation and an E or an e is added. The number of 0 and # placeholders 
to the right of the decimal determines the number of digits in the exponent. E- and e- place a minus sign by negative 
exponents. E+ and e+ place a minus sign by negative exponents and a plus sign by positive exponents.

\ Escape character. Displays the character following the backslash. The backslash is not displayed. You can also display a 
character or string of characters by surrounding the characters with double quotation marks (" ").

[ ] Displays hours greater than 24, or minutes or seconds greater than 60. Place the brackets around the leftmost
part of the time code; for 

<, <=, >=, > or 
<>

Operator. Restricts a format to a range of values. For example, [<50] 0.00 would make all values less than 50 
be displayed as fixed width with two decimal places.

"text" Displays the text inside the quotation marks.

@ Text placeholder. Text replaces the @ format character.    (e.g. ***@*** becomes ***labeltext***)

m Month number. Displays the month as digits without leading zeros (e.g., 1-12). Can also represent minutes when used with
h or hh formats.

mm Month number. Displays the month as digits with leading zeros (e.g., 01-12). Can also represent minutes when used with 
the h or hh formats.

mmm Month abbreviation. Displays the month as an abbreviation (e.g., Jan-Dec).

mmmm Month name. Displays the month as a full name (e.g., January-December).

d Day number. Displays the day as digits with no leading zero (e.g., 1-9).



dd Day number. Displays the day as digits with leading zeros (e.g., 01-31).

ddd Day abbreviation. Displays the day as an abbreviation (e.g., Sun-Sat).

dddd Day name. Displays the day as a full name (e.g., Sunday-Saturday).

yy Year number. Displays the year as a two-digit number (e.g., 00-99).

yyyy Year number. Displays the year as a four-digit number (e.g., 1900-2078).

h Hour number. Displays the hour as a number without leading zeros (1-23). If the format contains one of the AM or PM 
formats, the hour is based on a 12-hour clock. Otherwise, it is based on a 24-hour clock.

hh Hour number. Displays the hour as a number with leading zeros (01-23). If the format contains one of the AM or PM 
formats, the hour is based on a 12-hour clock. Otherwise, it is based on a 24-hour clock.

m Minute number. Displays the minute as a number without leading zeros (0-59). The m format must appear immediately 
after the h or hh symbol. Otherwise, it is interpreted as a month number.

mm Minute number. Displays the minute as a number with leading zeros (00-59). The mm format must appear immediately 
after the h or hh symbol. Otherwise, it is interpreted as a month number.

s Second number. Displays the second as a number without leading zeros (0-59).

ss Second number. Displays the second as a number with leading zeros (00-59).

AM/PM

am/pm

A/P

a/p

12-hour time. Displays time using a 12-hour clock. Displays AM, am, A, or a for times between midnight and noon; displays
PM, pm, P, or p for times from noon until midnight.

[BLACK] Displays text in black

[BLUE] Displays text in blue.

[CYAN] Displays text in cyan.

[GREEN] Displays text in green.

[MAGENTA] Displays text in magenta.

[RED] Displays text in red.

[WHITE] Displays text in white.

[YELLOW] Displays text in yellow.

[COLOR n] Not supported in this version.

[COLOR r,g,b,] Displays text allowing an arbitrary RGB value to be selected as the color.

Other 
Characters

Any character that is not interpreted as one of the above format characters is interpreted as a literal.

Axis Titles
You can add a title for each axis. Axis titles can provide additional information about the axis that helps 
the viewer interpret the chart.

To create an axis title:

1. Use the right mouse button to display the floating menu.



2. Select Axis from the Title menu to display the Format Axis Title dialog box.

3. Check the Visible check box to display the title.

4. Type the title text in the Text field.

5. Click OK or Apply to redraw the chart to include the new title.

The following table describes each of the tabs on the Format Axis Labels dialog box.

Tab Description
Text Controls the text used for the axis title as well as the orientation and alignment of the text.

Backdrop Controls the fill, frame, and shadow used to create a backdrop for the axis title.

Font Controls the font, font size, font color, font style, and special effects used to display the axis 
title. 

Related Topics:

Formatting Axes 

Axis Terminology 

Formatting Axis Labels 

Format Axis Labels Dialog 

Controlling Label Position 

Standing Labels 

Axis Label Text Formatting 



Plot Options
Several chart types have options that customize the appearance or organization of the entire chart. These
options are located in the Options tab of the Format Plot dialog box. 

To format plot options:
1. Double-click the chart plot; or, click the right mouse button to display the floating menu and select 

Plot.

2. Select the Options tab from the Format Plot dialog box.

The enabled options on the tab vary depending on the current chart type.

3. Change any of the settings.

4. Click OK or Apply to redraw the chart to reflect the changes.

Related Topics:

Controlling Bar Spacing 

Controlling Chart Direction 

Starting Angle Rotation 

Chart Layout Options 

Pie and Doughnut Chart Options 



Controlling Bar Spacing
There are three settings that control the spacing between bars on bar and hi-lo charts. The Bar Gap Ratio
controls the distance between bars withing a category and applies only to 2D bar charts. The default bar 
gap of 50 percent places a space between each bar that is half as wide as the bars. 

For specific information about how to set the bar spacing for your chart, see the Format Plot Options tab. 

The following illustration shows the results of other bar gap settings. 

The Z Gap Ratio controls the distance between series of bars on the Z axis of a 3D chart. You can set the
Z Gap Ratio to any value between 0 and 10,000. The Z-Gap Ratios only applies to 3D charts. The 
following illustration shows various Z Gap settings.

The    X Gap Ratio controls the distance between individual bars on the X axis of a 3D bar chart and the 
space between categorys of bars on 2D bar and hi-lo charts and applies to both 2D bar and 3D bar 
charts. The following illustration shows various X Gap settings.



Related Topics:
Plot Options 
Starting Angle Rotation 

Controlling Chart Direction 

Chart Layout Options 

Pie and Doughnut Chart Options 



Controlling Chart Direction
The options in the Rotation section of the Options tab control how pie, doughnut, polar, and radar charts 
are drawn. You can draw these charts in a clockwise or counterclockwise direction. For specific 
information about how to control chart direction, see The Format Plot Options tab.

The following illustration depicts variations in chart direction.

Related Topics:
Plot Options 
Controlling Bar Spacing 
Starting Angle Rotation 
Chart Layout Options 
Pie and Doughnut Chart Options 



Starting Angle Rotation
First Impression provides a method for specifying the starting point on    a circle at which drawing begins 
for pie, doughnut, polar and radar charts. This is known as Starting Angle Rotation. Valid values are 
between -360 and 360. Values can be measured in degrees, radians or grad depending on the setting in 
the Angle Units option of the Format Plot options tab. 

The following illustartion demonstrates a starting angle of 0 and 90 degrees. 

Related Topics:
Plot Options 
Controlling Bar Spacing 
Controlling Chart Direction 
Chart Layout Options 
Pie and Doughnut Chart Options 



Chart Layout Options
The Options tab of the Format Plot dialog provides the controls that affect all elements of the chart. The 
Element Layout section of this tab is particularly useful for pie and doughnut chart layout.

Sorting is defined as the order in which the slices of pie and doughnut charts are drawn. The following 
table lists the options for sorting a chart.

Setting Description
None Pie slices are drawn in the order the data appears in the data grid.

Ascending Pie slices are drawn from the smallest to the largest slice, starting at the defined starting angle.

Descending Pie slices are drawn from the largest to the smallest slice, starting at the defined starting angle.

Weighting is defined as the size of each pie or doughnut in relation to the other pies or doughnuts in the 
same chart. The following table lists the options for weighting a chart.

Setting Description
None All pies and doughnuts are drawn the same size.

Pie Total The slice values in each pie are totaled and the pie with the highest total identified. The size of each pie in 
the chart is determined by the ratio of its total value compared to the largest pie. 

First Series The size of a pie is determined by the relationship of values in the first series of each pie. The larger the 
value in the first series, the bigger the pie. It is most common to exclude this first series so that the values 
are not drawn as pie slices.

Related Topics:

Plot Options 

Controlling Bar Spacing 

Controlling Chart Direction 

Starting Angle Rotation 

Pie and Doughnut Chart Options 



Pie and Doughnut Chart Options
If you are plotting data on a pie or doughnut chart, thickness ratio can make your chart more interesting. 
Thickness ratio is defined as the percentage of the pie or doughnut radius that determines the height of a 
3D pie or doughnut. The higher the percentage, the taller the pie or doughnut. 

The following illustration demonstrates the thickness ratio of a doughnut chart.

Top Radius Ratio. is defined as    the percentage of the pie radius that is used to draw the top of a 3D 
pie. A ratio of 100 draws a cylinder; values less than 100 result in a tapering of the top of the pie. A value 
of 0 results in a cone. The following illustration demonstrates top radius ratio with pie charts.

Interior Ratio. is defined as    the ratio of the entire doughnut size that is used to display the interior "hole"
of the doughnut. Valid values are any number between 0 percent and 100 percent.The following 
illustration demonstrates interior ratio on a doughnut chart.

With First Impression, you can control the number of sides used to draw a doughnut. More sides give the 
doughnut a rounder, smoother appearance. If you enter a value of 1 in this option, First Impression 
determines the number of sides needed to draw a round doughnut based on the size of the doughnut. 
The maximum value for this option is 360. The following illustration depicts variations in doughnut chart 
sides.

Note      A very large number of sides may impact performance. 

For specific information on how to set these options of your pie or doughnut chart, see the Format Plot 



options tab.

Related Topics:

Plot Options 

Controlling Bar Spacing 

Controlling Chart Direction 

Starting Angle Rotation 

Chart Layout Options 



Formatting Series and Data Points
There are a number of things that you can do to format individual series or data points in a chart. You can:

Plot series data from rows rather than columns of the data grid.
Hide or exclude a series.
Plot the series on a secondary Y axis.
Change the appearance of the elements that make up the series.
Change the fill and line colors used to display series elements or individual data points.
Add or modify markers used to identify series elements or individual data points.
Add statistics lines or guidelines to highlight series information.

Related Topics:

Supplying Series Data 

Formatting Series Data 

Setting Series Options 

Bar Shapes 

Smoothing Series Data 

Hi-Lo-Close Colors 

Changing the Series Fill and Pen 



Supplying Series Data
When charting series data, you might first want to indicate that the data being plotted on the chart is read 
from rows in the data grid rather than from columns. 

To Read Data Series In Rows:

1. Click the right mouse button to disply the floating menu and select General from the menu.

2. Choose the Options tab

3. Click the Data Series in Rows box to indicate that the data is being supplied from rows in the data 
grid rather than columns.

Related Topics:

Formatting Series and Data Points 

Formatting Series Data 

Setting Series Options 

Bar Shapes 

Smoothing Series Data 

Hi-Lo-Close Colors 

Changing the Series Fill and Pen 



Formatting Series Data
To format a chart series:

1. Double-click the series in the chart or the legend key that identifies the series.

The Format Series dialog box is displayed.

Alternatively, you can use the right mouse button to display the floating menu and select Series 
from the menu. Then, select the series you want to format from the Select Data Series dialog box 
and click Select.

The Format Series dialog box appears with either the Fill or Line tab selected.

2. When you have made all the formatting changes required for the series, click OK or Apply to 
redraw the chart to reflect the changes you have made.

Related Topics:

Formatting Series and Data Points 

Supplying Series Data 

Setting Series Options 

Bar Shapes 

Smoothing Series Data 

Hi-Lo-Close Colors 

Changing the Series Fill and Pen 



Setting Series Options
The options in the Format Series Options tab hide or exclude a series, plot the series on a secondary Y 
axis, change style of bars on a bar chart, set the gain and loss colors used in a hi-lo chart, and control 
smoothing for line and area series types

If you choose to hide a series, the space occupied by the series is still shown on the chart, but the data is 
not displayed. If you choose to exclude a series from a chart, the data is not displayed and the space 
occupied by the series is removed from the chart. 

The following illustration shows the difference between hiding and excluding a series.

The following illustration shows how hiding a series in a stacked chart can produce floating chart 
elements.

If you wish to plot the current series on the secondary Y axis instead of the primary axis, you can set that 
option on the Options tab of the Format Series dialog box. You may then want to change the scale, type, 
or format of the secondary axis to best display the series data. This can be done with the Options tab, as 
well.

Related Topics:

Formatting Series and Data Points 

Supplying Series Data 

Formatting Series Data 

Bar Shapes 

Smoothing Series Data 





Bar Shapes
To control the appearance of bars in 3D bar charts; including horizontal bar charts, gantt charts, and 
clustered bar charts, you can set these options on the Format Series Options tab.

You can specify the number of sides for bars by entering a value between 1 and 360 to indicate the 
number of sides for the bars. If you enter 1, First Impression determines how many sides are necessary 
to create a round column, given the size of the bar. The following illustration shows a number of different 
bar styles that can be created by changing the number of sides.

 
Top Ratio is defined as the percentage of the bottom diameter of a bar used to draw the top of the bar on
a chart. Valid numbers are between 0 and 10,000 to indicate the percent of the bottom diamete. Values 
less than 100 result in a top smaller than the bottom. Values greater than 100 result in the top wider than 
the bottom. The following illustration shows the effects of changing the top ratio on several bars. 

Related Topics:
Formatting Series and Data Points 
Supplying Series Data 
Formatting Series Data 



Setting Series Options 
Smoothing Series Data 
Picture Bars 



Smoothing Series Data
Smoothing is the process of using one of several mathematical formulas to divide the chart data into a 
number of facets. When the chart is drawn using these facets, the result is a smoother curve to the series 
lines. 

You can smooth line and area series chart types. The following illustration shows the results of smoothing 
the series in a 3D area chart.

You can control series smoothing by setting the correct options on the Format Series Options tab. The 
following table describes the smoothing formulas that can be used to smooth series data.

Smoothing Type Description
None No smoothing is applied to the data.

QuadraticBSpline A quadratic B-spline formula determines the smoothing applied to the data. This form of 
smoothing results in a less-smooth curve that stays closer to the data points.

CubicBSpline A cubic B-spline formula determines the smoothing applied to the data. This form of smoothing 
results in a smoother curve, but varies further from the data point than a QuadraticB spline 
curve.

In order to smooth series data, you must specify the series smoothing factor. The Factor is the number of
facets or points sampled between the chart data points to create the smoothing effect. The higher the 
number, the more smoothing occurs. 

Related Topics:

Formatting Series and Data Points 

Supplying Series Data 

Formatting Series Data 

Setting Series Options 

Bar Shapes 

Hi-Lo-Close Colors 

Changing the Series Fill and Pen 



Hi-Lo-Close Colors
Hi-Lo charts are most commonly used to show stock market information. A hi-lo-close chart calculates 
whether the close value for a data point was a gain or a loss from the close value of the previous data 
point. In other words, the first data point never has a gain or loss color, but sets the basis for deciding if 
the next data point displays a gain or loss. The open-hi-lo-close bar chart calculates whether the close 
point was a gain or loss from the open value for the same point.Gains and losses are calculated 
differently between open-hi-lo-close bar charts and other variations of hi-lo-close charts. 

You can control the colors used to display the elements of a hi-lo chart by setting the appropriate options 
on the Format Series Options tab. On this tab, you can select both the Gain Color    and Loss Color to 
be represented on your chart.

Related Topics:

Formatting Series and Data Points 

Supplying Series Data 

Formatting Series Data 

Setting Series Options 

Bar Shapes 

Smoothing Series Data 

Changing the Series Fill and Pen 



Changing the Series Fill and Pen
You can use options on the Fill tab to change the color, pattern, and edge pen used to display the series 
elements. If the series is a 2D bar type, you can also specify a graphic image to use as the fill for the 
bars.

The following illustration shows the organization of the pattern picker.

Patterns are bitmaps. A low resolution version of each bitmap is used to display the pattern on the screen.
When you print a chart, a high resolution version of the bitmap is used if the output device prints at more 
than 144 dpi. The higher the resolution of the output device, the smaller the copies of the bitmaps that 
make up the patterns are reproduced. At high resolutions, First Impression adjusts the patterns to prevent
the lines from getting too close together. 
Hatches are not bitmaps, but actual lines drawn to fill the object. They are always drawn at the same 
resolution, regardless of the output device. 
The fill color is used as the color for solid patterns. It is used as the background color for any other type 
of pattern. By default, the line color for an element matches this fill color.
The pattern color is used to draw the pattern over the fill color if any pattern other than solid is selected. 
The edge pen outlines all 3D objects and all 2D elements except the lines in line, XY, hi-lo, radar, and 
polar charts.

For specific information on how to set these options, see the Format Series Fill tab.

Related Topics:

Formatting Series and Data Points 

Supplying Series Data 

Formatting Series Data 

Setting Series Options 

Bar Shapes 

Smoothing Series Data 

Hi-Lo-Close Colors 



Picture Bars
You can specify a graphic image to use as the fill for a series of 2D vertical or horizontal bars or gantt 
charts.

A control on the Fill tab of the Format Series dialog box displays a preview of the graphic. When a valid 
path and file name are entered in the File text box, the picture is displayed in the Picture control. Only 
Windows Bitmap (.bmp) and Windows Metafiles (.wmf) are supported graphic formats.

If you create picture bars using a Windows metafile, the pictures will not appear if you save the chart as a 
metafile. This is a Windows limitation that prevents a metafile from containing another metafile. If you plan
to copy the chart to the clipboard, or save the chart as a metafile, use a bitmap for the picture bars 
instead of a metafile.

You can choose how to fit the graphic into the bar by setting the Fit Method. The following table lists the 
options for fitting graphics.

Fit Method Description
Stacked Duplicates the graphic repeatedly to fill the bars. Since this uses multiple copies of the graphic, it is 

recommended that you use as small a file as possible.

Stretch To Fit Scales the graphic to fit the bars regardless of its original proportions.

To fill 2D bars interactively, use the following steps:

1. Select the bar you want to fill on the chart.

2. Click the right mouse button to display the floating menu and select Paste.

3. Identify the graphic you want to paste into the bar and click OK.

The following illustration shows an example of a different graphic used to identify each series in a chart 
using the stacked fit method.

Some graphics products output bitmap files in an older format that is compatible with OS/2. First 
Impression does not support these bitmaps. If you attempt to use one of these files, you receive an error, 
"Invalid picture format." You can read these files into PaintBrush and save them as BMPs to convert them 
to the newer bitmap format. First Impression can then use these files without any problems.

Related Topics:

Bar Shapes 



Changing the Series Fill and Pen 



Formatting Lines
The controls on the Line tab of the Format Series dialog box format the style, width, color, joint, and end 
caps of 2D lines and the lines in XY, radar, polar, and hi-lo charts.

Join styles determine how the lines on your chart will look at the point where they join or meet. Join 
styles are particularly important when using thick lines on your chart. The following table lists the valid line
join styles.

Join Types Description
Mitered The outer edges of the two lines are extended until they meet.

Round A circular arc is drawn around the point where the two lines meet.

Beveled The notch between the ends of two joining lines is filled.

Important       Very acute mitered joins are automatically beveled to avoid drawing large spikes along the 
line.

The following illustration shows an example of each join style.

Cap styles determine how the end of each line on your chart is capped. Line caps can enhance the 
appearance of your chart, particularly if you are using large or thick lines to plot data.

The following table lists valid line cap styles:

Cap Type Description
Butt The line is squared off at the endpoint.

Round A semicircle with a diameter of the line thickness is drawn at the end of the line.

Squared The line continues beyond the endpoint for a distance equal to half the line thickness and is squared 
off.

The following illustration shows an example of each cap style.



For specific information on how to format lines, see the Format Series Line tab.

Related Topics:

Formatting Markers 

Formatting Statistics Lines 

Formatting Guidelines 

Formatting Data Points 



Formatting Markers
The Markers tab on the Format Series dialog box controls the style, color, size, and line width used to 
display markers. Markers can be displayed on all chart types except pies and doughnuts. 

The Show Markers control determines whether or not to display markers on a series. You can use this 
control to remove markers from a series.

An Automatic check box allows First Impression to use the next available marker to identify the series. 
You can uncheck the Automatic check box to select your own choice of marker.

If the Automatic check box is unchecked, you can specify a marker style, color, size, and line width for 
your chart from the Markers tab. 

Related Topics:

Formatting Lines 

Formatting Statistics Lines 

Formatting Guidelines 

Formatting Data Points 



Formatting Statistics Lines
The options in the Statistics tab of the Format Series dialog box control the display and appearance of 
statistics lines for a series. Statistics lines are useful for analyzing data by showing information such as 
minimum value, maximum value, mean value, standard deviation, and regression trendlines. You can only
display statistics lines on 2D line and XY charts. The following illustration depicts statistics lines on a 
chart.

The following table describes each type of statistic.

Statistic Type Description
Minimum Shows the minimum Y value in the series.

Maximum Shows the maximum Y value in the series.

Mean Shows the mathematical mean of the Y values in the series.

Standard Deviation Shows the standard deviation of the Y values in the series.

Regression Shows a trend line indicated by the Y values in a series.

Related Topics:

Formatting Lines 

Formatting Markers 

Formatting Guidelines 

Formatting Data Points 



Formatting Guidelines
The Guidelines Tab of the Format Series dialog box controls the display and format of guidelines for the 
series in 2D and 3D line, area, and step charts as well as bubble charts, 3D xyz and scatter charts. 
Guidelines are lines that are drawn from a data point to one or more axis to better identify the data point 
position. The following illustration shows guidelines on several types of charts.

Related Topics:

Formatting Lines 

Formatting Markers 

Formatting Statistics Lines 

Formatting Data Points 



Formatting Data Points
By default, each data point in a series has the same format. However, there may be times that you want 
to highlight one or more data points in a series by changing their format. 

To format an individual data point:

1. Click a data point to select its series. 

2. Click the data point again to select just the data point. 

3. Double-click the data point to display the Format Data Point dialog box.

Alternatively, you can click the right mouse button to display the floating menu and select Series, 
Data Point. A dialog box appears asking you to specify the series and data point you want to 
format. You can pick Series Defaults to format the default fill and markers for the entire series.

The Options tab of the Format Data Point dialog box is displayed. 

4. Uncheck the Use Series Defaults check box to ungray the Fill and Markers tabs. You can then 
change any of the Fill or Marker options used to display the data point. Check the Use Series 
Defaults check box to discard any custom settings you have made for the data point and reset all 
options to the series defaults.

5. Click the Fill tab to modify the fill options for the data point.

6. Click the Marker tab to modify the marker options for the data point.

Related Topics:

Formatting Lines 

Formatting Markers 

Formatting Statistics Lines 

Formatting Guidelines 



Formatting Labels
You can place labels on a series of data points or on individual data points to annotate the chart or draw 
attention to a certain chart element. The following illustrations show several uses of data point and series 
labels.

Related Topics:
Series Labels 

Series Label Options

Data Point Labels 

The Format Data Point Label Dialog 

Label Options 

Controlling Label Type

Formatting Label Text



Series Labels
Series labels can be used instead of the legend, as a way to identify each series on a line, area, step, XY,
or radar chart.

To format a series label:

1. If a series label exists, double-click it. Otherwise, use the right mouse button to display the floating 
menu and select Series Label.

2. Specify the series for which you want to define a label and click Select to display the Format 
Series Label dialog box.

The following table briefly describes the tabs of options available in the Format Series Label dialog box.

Tab Description
Options Controls the display and placement of the label as well as the display and type of line 

connecting the label to the series.

Text Controls the text used for the series label as well as the orientation and alignment of the text. 

Font Controls the font, font size, font style, font color, and special effect used to display the label 
text. 

Backdrop Controls the fill, frame, and shadow used to create a backdrop for the label. 

3. Make any other changes to the series labels. Then, click OK or Apply to redraw the chart to reflect 
the changes.

Related Topics:

Formatting Labels 

Series Label Options 

Data Point Labels

The Format Data Point Label Dialog 

Label Options 

Controlling Label Type 

Formatting Label Text 



Series Label Options
The Options tab of the Format Series Label dialog box controls the display and position of the series label
as well as the line style used to connect the label to the series.

First Impression offers several predefined positions for placing series labels. The following table describes
the valid positions for series labels.

Positions Description
None Hides the label.

First The label is displayed above the first data point in the series.

Last The label is displayed above the last data point in the series.

Center The label is displayed above the middle data point in the series.

There are three Label Line styles available in First Impression to display a line connecting a label to the 
series it represents. The    Label Line Styles are described in the following table.

Line Styles Description
None No line connects the label and series.

Line A straight line connects the label and series.

Angle Line An angled line connects the label and series.

Related Topics:

Formatting Labels 

Series Labels

Data Point Labels 

The Format Data Point Label Dialog 

Label Options 

Controlling Label Type 

Formatting Label Text 



Data Point Labels
You can format data point labels for all the data points in a series or for an individual data point. Data 
point labels can provide additional information about, or draw attention to, a data point. The following 
illustration shows two types of data points.

The data point value for May has been formatted to signify record sales.

To format data point labels:

1. Double-click the existing data point label to display the Format Data Point Label dialog box.

Alternatively, you can click the right mouse button to display the floating menu and select Series Data 
Point Label. A dialog box appears asking you to specify the series and data point you want to 
format. You can pick Series Defaults to format the data point labels for every data point in the 
series.

2. Uncheck the Use Series Defaults check box to enable other tabs in the dialog box. You can then 
change any of the options used to display the data point. Check the Use Series Defaults check box
to discard any custom settings you have made for the data point label and reset all options to the 
series defaults.

Related Topics:

Formatting Labels 

Series Labels

Series Label Options

The Format Data Point Label Dialog 

Label Options 

Controlling Label Type 

Formatting Label Text 



The Format Data Point Label Dialog
The following table briefly describes the tabs available in the Format Data Point Label dialog box

Tab Description
Options Controls the display and placement of labels as well as the display and type of lines 

connecting the labels to the series.

Text Controls the text used for the data point label as well as the orientation and alignment of the 
text.

Font Controls the font, font size, font style, font color, and special effect used to display the label 
text. 

Backdrop Controls the fill, frame, and shadow used to create a backdrop for the label. 

Value Format Controls the mask used to display the data point label when the text is displayed as a value.

Percent Format Controls the mask used to display the data point label when the text is displayed as a 
percentage.

Note       Make any necessary changes to the tabs in the Format Data Point dialog box and click OK or 
Apply to redraw the chart to reflect the changes.

Related Topics:

Formatting Labels 

Series Labels 

Series Label Options 

Data Point Labels 

Label Options 

Controlling Label Type 

Formatting Label Text



Label Options
The Options tab of the Format Data Point Label dialog box controls the position of the data point label and
the line style used to connect the label to the data point. 

Nine preset locations are available to position data point labels. The following table lists the available 
locations..

Locations Description
None No label displayed.

Above Point The label is displayed above the data point. This location is only valid for bar, line, area, step, XY, polar, 
radar, and bubble charts.

Below Point The label is displayed below the data point. This location is only valid for bar, line, area, step, XY, polar, 
radar, and bubble charts.

Center The label is displayed centered on the data point. This location is only valid for bar, line, area, step, xy, 
polar, radar and bubble charts.

Base The label is displayed along the category axis, directly beneath the data point. This location is only valid for 
bar, line, area, and step charts.

Inside The label is displayed inside a pie or doughnut slice.

Outside The label is displayed outside a pie or doughnut slice.

Left The label is displayed to the left of the data point. This location is only valid for XY, polar, radar, and bubble 
charts.

Right The label is displayed to the right of the data point. This location is only valid for XY, polar, radar, and 
bubble charts.

There are three Label Line Styles available for displaying the line that connects the data point and its 
label. The following table lists the line styles available. 

Line Styles Description
None No line connects the label and series.

Line A straight line connects the label and data point.

Angle line An angled line connects the label and data point.

Related Topics:

Formatting Labels 

Series Labels 

Series Label Options 

Data Point Labels 

The Format Data Point Label Dialog 

Controlling Label Type 

Formatting Label Text 



Controlling Label Type
The settings on the Text tab of the Format Data Point Label dialog box control the type of label displayed 
on the data point. 

First Impression will automatically create a data point label for you, if you select the Automatic option. 
You can indicate the type of label you would like by selecting the appropriate radio button. The available 
label types described in the following table. If you select more than one type, the labels are stacked on 
top of each other.

Type Description
Value The value of the data point appears in the label.

Percent The value of the data point is displayed in the label as a percentage according to the axis percent 
basis.

Series Name The series name is used to label the data point. 

Data Point Name The category name is used to label the data point. 

If you dont wish to use one of the available label types, you can choose to enter custom label text by 
selecting the Custom radio button, and entering the desired text in the text box of the Text tab. 

The following illustration shows the use of automatic and custom data point labels.

Related Topics:
Formatting Labels

Series Labels 

Series Label Options 

Data Point Labels 

The Format Data Point Label Dialog 

Label Options 

Formatting Label Text 



Formatting Label Text
You can specify a display mask to control the appearance of the data point labels. On the Format Data 
Point Label dialog box, use the settings on the Value Format tab to format the label when it is displayed 
as a value. Use the settings on the Percent Format tab to format the label when it is displayed as a 
percent.

Related Topics:

Formatting Labels 

Series Labels 

Series Label Options 

Data Point Labels 

The Format Data Point Label Dialog 

Label Options 

Controlling Label Type 



Elevation Charts
Elevation charts can be drawn as a 2D contour chart or a 3D surface chart. Use the Chart Type list in the 
Type tab of the Format Plot dialog box to specify which chart type you wish to draw.

The following illustration depicts a contour and a surface chart.

Related Topics:
The Elevation Tab 
Displaying Contours 
Displaying Chart Bases 
Surface Chart Projection 
Displaying Chart Surfaces 
Displaying Wireframe Surfaces 
Chart Surface Smoothing 
Displaying Elevation and Contour Data



The Elevation Tab
Once you have specified the type of chart you wish to draw, you can format both elevation and contouring
information for the chart. Contour and elevation options are divided between two tabs in the Format Plot 
dialog box. The Elevation tab contains basic contour and surface options. The Contouring tab controls the
assignment of colors and line widths used in the actual contour bands and lines.

In each tab, the available options depend on the chart type you have specified and will be disabled 
(grayed) if they do not apply to the current chart type.

Related Topics:

Elevation Charts 

Displaying Contours 

Displaying Chart Bases 

Surface Chart Projection 

Displaying Chart Surfaces 

Displaying Wireframe Surfaces 

Chart Surface Smoothing 

Displaying Elevation and Contour Data 



Displaying Contours
The purpose of contouring is to identify areas on a surface or contour chart that have like contour values. 
On a surface chart, the contour data is the elevation data itself.    In such a chart, contour bands are 
painted upon the surface along areas within given elevation ranges while contour lines are striped along 
areas at specific elevations. 

Basic contour information is contained in an array of contour attributes each of which define a contour 
band or line.    Each element in the array consists of a contour value, brush for contour bands, pen for 
contour lines, and an optional label which is used to identify the contour element in a contour legend. 

When displaying contour bands on a chart, areas on the chart whose contour values lie directly beneath a
given elements value (but above the preceeding elements value) are filled using that elements brush.    
When displaying contour lines on a chart, areas on the chart whose contour values exactly match a given 
elements value are striped using that elements pen.

The Format Plot Elevation tab allows you to set the types of contour you wish to display on your chart. 
The following table lists the available contour types

Type Description

Bands Contours are displayed as bands of color.

Lines Contours are displayed as colored lines.

To learn how to set the contour type for your chart, see The Format Plot Elevation tab.

Related Topics:

Elevation Charts 

The Elevation Tab 

Displaying Chart Bases 

Surface Chart Projection 

Displaying Chart Surfaces 

Displaying Wireframe Surfaces 

Chart Surface Smoothing 

Displaying Elevation and Contour Data 



Displaying Chart Bases
In addition to displaying variations in data as contours on their surface, surface charts can also reflect 
data variation in the base of the chart. There are four different surface chart base types. A chart base of 
type bands or lines will reflect the charts contours in the base. A chart base of type pedestal or standard
does not reflect any of the charts contours.The following table defines each of the four base types:

Type Description

Pedestal The base is displayed as a solid area that rises up to meet the surface.

Standard The base is displayed as a flat area beneath the chart surface.

Bands The base reflects the charts contours as a series of contour bands.

Lines The base reflects the charts contours as a series of contour lines.

The following illustration depicts the various surface chart bases.

For specific information about how to select the base type for your chart, see The Format Plot Elevation 
tab.
Related Topics:
Elevation Charts 

The Elevation Tab 

Displaying Contours 

Surface Chart Projection 

Displaying Chart Surfaces 

Displaying Wireframe Surfaces 

Chart Surface Smoothing 

Displaying Elevation and Contour Data 



Surface Chart Projection
Projection is a charting technique that displays a planar contour chart projected above a surface chart. 
The following table defines the three available projection options:

Method Description

None No projection is displayed above the chart.

Bands The planar chart reflects the charts contours in contour bands.

Lines The planar chart reflects the charts contours in contour lines.

This illustration demonstrates the two projection methods which display the contours of the surface chart 
below.

To learn how to set the projection method for your surface chart, see The Format Plot Elevation tab..
Related Topics:

Elevation Charts 

The Elevation Tab 

Displaying Contours 

Displaying Chart Bases 

Displaying Chart Surfaces 

Displaying Wireframe Surfaces 

Chart Surface Smoothing 

Displaying Elevation and Contour Data 



Displaying Chart Surfaces
There are five ways to represent the surface on a 3D surface chart. The following table lists the five 
options:

Type Description

None The surface data is represented exclusively by a wireframe.

Bands The surface displays changes in data with contour bands.

Lines The surface is represented by a wireframe and displays changes in data with contour lines.

Solid The surface is drawn with a solid color.

Solid with Lines The surface is drawn with a solid color. Changes in data are indicated by contour lines super imposed 
on the solid color.

The following illustration demonstrates chart surfaces.

For specific information on how to select your charts surface type, see The Format Plot Elevation tab.
Related Topics:

Elevation Charts 

The Elevation Tab 

Displaying Contours 

Displaying Chart Bases 

Surface Chart Projection 

Displaying Wireframe Surfaces 



Chart Surface Smoothing 

Displaying Elevation and Contour Data 



Displaying Wireframe Surfaces
If you choose not to display a surface on your 3D surface chart, then the surface is represented 
exclusively by a wireframe. Surface wireframes can be displayed through variations in pen color and the 
interval at which the wireframe appears along the charts surface. The following table lists the wireframe 
options available on The Format Plot Elevation tab.

Type Description

None The surface is represented by the surface color only.

Major The wireframe indicates the original data grid values.

Major and Minor The wireframe is drawn upon the surface along the original data grid values and any additional rows or 
columns generated by the smoothing process.

The following illustration shows several wireframe surface charts.

Related Topics:
Elevation Charts 
The Elevation Tab 
Displaying Contours 
Displaying Chart Bases 
Surface Chart Projection 
Displaying Chart Surfaces 
Chart Surface Smoothing 
Displaying Elevation and Contour Data 



Chart Surface Smoothing
Smoothing can be applied to both contour and surface charts. You can use smoothing to create rounder, 
smoother contours. First Impression uses the bi cubic B spline formula to determine how to smooth the 
chart data based on the smoothing factor you specify in The Format Plot Elevation tab. The following 
table describes valid smoothing factors:

Factor Description

 0 The raw grid data is used with no smoothing.

1 This factor samples the spline data only at the original data grid locations.

2-32 A factor of 2 or more will break the row and column locations into the specified number of subdivisions.

Note      Since smoothing occurs for both rows and columns, a smoothing factor of 2 breaks a surface 
patch into 4 subpatches while a smoothing factor of 4 breaks a patch into 16 subpatches. Higher 
smoothing factors may slow drawing speed significantly.

The following illustration depicts chart smoothing.

Related Topics:

Elevation Charts 

The Elevation Tab 

Displaying Contours 

Displaying Chart Bases 

Surface Chart Projection 

Displaying Chart Surfaces 

Displaying Wireframe Surfaces 

Displaying Elevation and Contour Data 



Displaying Elevation and Contour Data
A contour chart displays only contour data, but a surface chart can display both contouring and elevation 
data. Normally, all data in a data grid represents both contouring and elevation. If you choose to use 
separate contour data, then the data grid is divided vertically between columns into two equal subranges 
of data. The left subrange contains elevation data, and the right subrange contains contouring data. 

When Use Separate Contour Data is enabled, a surface chart will display surface contours that do not 
necessarily conform to the shape of the surface. For example, a surface chart displaying separate contour
and elevation data might depict snowfall across a mountain range.

The following illustration demonstrates how the Use Separate Contour Data option can affect a surface 
chart display:

To enable Use Separate Contour Data for your chart, see the Format Plot Elevation tab.
Related Topics:

Displaying Contours 

Displaying Chart Surfaces 

Chart Surface Smoothing 

Formatting Contouring Options 

Displaying Contour Chart Colors 

Modifying Contour Colors 



Formatting Contouring Options
Unless otherwise specified, contours are drawn on a chart at major axis divisions. You may wish to 
increase or decrease the number of contours that appear on your chart in order to best plot your specific 
data. First Impression provides methods for designing custom contours for your chart by setting the 
appropriate options.

The first step in designing custom contours for your chart is to disable the Automatic Values option on 
the Format Plot Contouring tab. When the Automatic Values option is disabled, you can customize 
contours by modifying current contours, adding new contours or deleting existing ones. You can also label
contours. Value labels appear in the legend. 

To add a new contour:

1. Select a contour value from the contour list.

2. Click the new button.

A new value will be inserted in the contour list.

3. Double-click the number displayed in the Value window of the Contouring tab.

4. Type the new value for the contour.

The contour list will be re-ordered to display the new value in the appropriate location.

5. Click Apply or OK to redraw the chart to reflect the changes.

To delete an existing contour:

1. Select a contour value from the contour list.

2. Click the delete button.

3. Click Apply or OK to redraw the chart to reflect the changes.

To modify a contour:

1. Select a contour value from the contour list.

2. Double-click the number displayed in the Value window of the Contouring tab.

3. Type the new value for the contour.

4. Click Apply or OK to redraw the chart to reflect the changes.

To add a contour label: 

1. Select a contour value from the contour list.

2. Click once in the Value Label window of the Contouring tab.

3. Type the value label you wish to appear in the legend.

4. Click Apply or OK to redraw the chart to reflect the changes.

Related Topics:

Chart Surface Smoothing 

Displaying Elevation and Contour Data 



Formatting Contouring Options 

Displaying Contour Chart Colors 

Modifying Contour Colors 



Displaying Contour Chart Colors
First Impression provides three ways to display color on a contour chart. The following table describes 
each of the valid color types:

Type Description

Automatic The contour colors are displayed as the default series colors.

Gradient The contours are displayed in an even transition of two colors. 

Manual Custom contour colors can be specified and modified by the user. 

(Manual colors is only available when Automatic values is unchecked.)

The following illustration demonstrates the three color types for contour charts:

To learn more about how to set Contour chart colors, see The Format Plot Contouring tab.
Related Topics:

Displaying Elevation and Contour Data 

Formatting Contouring Options 

Modifying Contour Colors 



Modifying Contour Colors
First Impression provides contour color display methods on    the Contouring tab of the Format Plot dialog 
box. When the contour colors option is set to Automatic, contour colors are automatically computed 
based on series colors. You can customize any contour color when the Colors option is set to manual. 
When the Colors option is set to gradient, only the To and the From color can be customized.

To modify contour band colors:

1. Select Manual from the Colors popup list.

2. Select one of the values listed in the contour list.

3. Select a band color from the Band Options Color pop up list.

4. Click Apply or OK to redraw the chart to reflect the changes.

To modify contour line colors:

1. Select Manual from the Colors popup list.

2. Select one of the values listed in the contour list.

3. Select a line color from the Line Options Color pop up list.

4. Click Apply or OK to redraw the chart to reflect the changes.

To modify gradient band colors:

1. Select Gradient from the Colors popup list.

2. Select the To value listed in the contour list.

3. Select a band color from the Band Options Color pop up list.

4. Select the From value listed in the contour list.

5. Select a band color from the Band Options Color pop up list.

6. Click Apply or OK to redraw the chart to reflect the changes.

To modify gradient line colors:

1. Select Gradient from the Colors popup list.

2. Select the To value listed in the contour list.

3. Select a line color from the Line Options Color pop up list.

4. Select the From value listed in the contour list.

5. Select a line color from the Line Options Color pop up list.

6. Click Apply or OK to redraw the chart to reflect the changes.

Related Topics:

Displaying Contours 

Displaying Elevation and Contour Data 



Formatting Contouring Options 

Displaying Contour Chart Colors



Exporting Charts
There are two ways to export copies of a chart from First Impression: by saving it to a file, or by copying it 
to the clipboard. 

To copy a chart to the clipboard:

1. Use the right mouse button to display the floating menu bar and select Copy. 

A copy of the current chart is placed on the clipboard in Windows Metafile format. You can then 
view the chart in any application that supports the .wmf format.

To save the chart to a file:

1. Use the right mouse button to display the floating menu bar and select Save As.

The Save As dialog box appears. 

2. Enter a name and path for the file.

3. Select a file type from the Save File As Type popup. 

You can save the chart in the native First Impression format (.vtc), as a standard metafile (.wmf), 
as a Windows bitmap (.bmp). By default, the Adobe placeable header information is included in the
metafile.

4. To save the metafile without the Adobe Placeable header information, check Save metafile without 
size information.

Do not check this option if you intend to use this metafile in a Microsoft application such as Word 
or Excel. These applications expect size information to be included in metafiles.

5. To save the text on the chart as curves check Save Text As Curves.

You should check this option if you are using an unusual font that may not be present on other 
systems that will be using the metafile. This option should also be used to properly display text if 
you are deforming the metafile by stretching it. 

6. Click Save.

Related Topics:

Loading Saved Charts 

Printing Charts 

Setting Print Options 

Specifying Page Size and Appearance 

Changing Printer Setup 



Loading Saved Charts
You can load a chart that was saved in First Impressions native format into the current chart control. Any 
chart that currently exists in the control is discarded.

To load a file:

1. Use the right mouse button to display the floating menu bar and select Load.

The Load Chart dialog box appears. A list of all .vtc files in the current directory is displayed.

2. Select the file you want to load.

3. Click OK. 

Related Topics:

Exporting Charts 

Printing Charts

Setting Print Options 

Specifying Page Size and Appearance 

Changing Printer Setup



Printing Charts
You can print a copy of the current chart.

To print a chart:

1. Use the right mouse button to display the floating menu bar and select Print to display the Print 
dialog box.

2. Make any necessary settings and click Print.

Specific information about the settings in the Print dialog box is presented in the following discussion.

Related Topics:

Exporting Charts 

Loading Saved Charts 

Setting Print Options 

Specifying Page Size and Appearance 

Changing Printer Setup 



Setting Print Options
The following illustration shows the settings on the Print tab.

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
Related Topics:
Exporting Charts 
Loading Saved Charts 
Printing Charts 
Specifying Page Size and Appearance 
Changing Printer Setup 



Layout radio buttons
Select Use Screen Layout to print the chart exactly as it appears on the screen. Select Layout for Printer 
to layout the chart to best fit the page. Chart elements such as axis labels and data points are 
repositioned as they would be if you had resized the chart on the screen.



Copies text box
Enter the number of copies of the chart you want printed.



Print button
Sends a copy of the chart to the printer.



Specifying Page Size and Appearance
You can use the options on the Page Setup tab to change page margins and control how the chart is 
positioned on the page. The following illustration shows the options on the Page Setup tab.

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
Related Topics:
Exporting Charts 
Loading Saved Charts 
Printing Charts 
Setting Print Options 
Changing Printer Setup 



Page Size radio buttons
Select Actual Size to print the chart at the original size it was created. Select Best Fit to scale the chart 
proportionally to fit the page. Select Stretch to Fit to scale an image of the chart to fit the page, regardless
of its original proportions.



Page Center check boxes
Check Center Horizontally to center the chart horizontally on the page. Uncheck Center Horizontally to 
print the chart at the left margin of the page. Check Center Vertically to center the chart vertically on the 
page. Uncheck Center Vertically to print the chart at the top margin of the page.



Page Margins text boxes
Enter a value in inches or centimeters, depending on your Windows settings to specify the top, bottom, 
left, and right margins of the page. 



Changing Printer Setup
The Print Setup tab provides standard Windows settings for selecting the printer, page orientation, and 
paper size and source. This Setup tab may appear differently depending on the system you are using.

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
Related Topics:
Exporting Charts 
Loading Saved Charts 
Printing Charts 
Setting Print Options 
Specifying Page Size and Appearance 



Printer Identification list box
Identifies the current printer, printer port and device.

This identification will differ depending on your operating system, unique printer options and devices.



Paper section
Size      Choose a paper size from the available options in the list box.

Source      Choose a paper source from the available options in the list box.



Orientation section
Landscape      Click here to print across the width of the page.

Portrait      Click here to print across the length of the page.



Properties button
Displays the printing properties for your particular printer.



The Format Chart Options Tab
The Format Chart dialog allows you to turn on or off the display of some common chart elements, reset
any chart formatting to its default values, and specify a backdrop for the entire chart. 

The Options tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Chart Backdrop Tab 



Printing
Choose this radio button to use TrueType virtual font metrics to optimize text layout for 
printing.TrueType virtual font metrics may not be very accurate for text displayed on the screen. Text 
displayed on the screen may be larger or smaller than the virtual metrics requested.    Larger text may 
not fit where it is supposed to and part of a character, a whole character, or even in some cases words 
may be clipped.



Screen Display
Choose this radio button to optimize text layout for the screen. Text in charts laid out for screen display 
always fits correctly within its chart area.    The printed text is generally a bit smaller and so the text 
may appear in slightly different places.



Show Title check box
Click this to display a chart title.



Show Footnote check box
Click this to display a chart footnote



Show Legend check box
Click this to display a chart legend.



Show 2nd Y Axis check box
Click this to display a secondary Y axis for the chart.



Data Series In Rows check box
Click this to read series data from data grid rows rather than columms.



Reset All Options to Default button
Click this to reset all chart options to their defaults settings.



The Format Chart Backdrop Tab
The Format Chart dialog allows you to turn on or off the display of some common chart elements, reset
any chart formatting to its default values, and specify a backdrop for the entire chart. 

The Backdrop tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Chart Options Tab



The Format Plot Type Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The Type Tab provides methods for determining whether your chart is a 2D or 3D chart, selecting the 
appropriate chart type, stacking data and setting type of data point markers.

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Backdrop Tab 
The Format Plot Options Tab 
The Format Plot 3D Lighting Tab 
The Format Plot Location Tab 
The Format Plot Order Tab 
The Format Plot 3D View Tab 
The Format Plot Base and Walls Tab 
The Format Plot Elevation Tab
The Format Plot Contouring Tab 



Chart radio buttons
Select the 2D radio button to display a list of the 2D chart types in the Chart Type list box. Select the 
3D radio button to display the 3D chart types.



Chart Type list box
Select a type from the list.



Stacked check box
Click this box to stack all the series of the current chart.



Percent Axis check box
Check the %Axis check box to add together all the values in each category. That value is considered 
100 percent. Then each data point in the category is drawn as a percentage of that sum.



Line or Markers
The options in this section of the dialog are enabled if you choose a 3D chart or a 2D chart type other 
than pie or bubble. Markers can represent the data points on the chart for all 2D types other than 
bubble and pie charts. Markers and lines can both represent all data points on 2D line, XY, Radar, and 
Polar charts. 



Series Name list box
Select a series from the list.



Series Type list box
Select the series type you want to use to display data from the list.



Ok Button
Applies changes to the chart and dismisses the dialog.



Cancel Button
Dismisses the dialog without applying changes.



Apply Button
Applies changes to the chart without dismissing the dialog



Help Button
Displays this Help screen.



The Format Plot Backdrop Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The Backdrop tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Type Tab 
The Format Plot Options Tab 
The Format Plot 3D Lighting Tab 
The Format Plot Location Tab 
The Format Plot Order Tab 
The Format Plot 3D View Tab 
The Format Plot Base and Walls Tab 
The Format Plot Elevation Tab
The Format Plot Contouring Tab 



No Fill radio button
The chart control or chart elements have no fill, so any formatting applied to the surface behind them 
shows through. A picture can still be applied to a element with no fill.



Pattern radio button and pop up menu
Click the radio button, then click the pop up menu to display the pattern picker. Click one of the 
patterns, click None to have no fill on the object, or Solid to use only the fill color to fill the object. 



Gradient radio button and pop up menu
Click on the radio button and select a gradient type from the popup menu.



Fill/From Color and Pattern/To Color pop up menus
Click the control to display the color picker. Choose a predefined color or click Custom to create your 
own color. 

The fill color is used to create a solid pattern. For a pattern fill, the pattern color is drawn on top of the 
fill color. 

For a gradient fill, use the Fill/From Color popup to specify the color used as the top color in a 
horizontal gradient, the left color in a vertical gradient, and the center color in a rectangle or oval 
gradient. Use the Pattern/To Color popup to specify the color used as the bottom color in a horizontal 
gradient, the right color in a vertical gradient, and the outer color in a rectangle or oval gradient.



Picture buttons
Clear. Click this button to clear an existing picture from the backdrop. Some graphics files can be very 
large. In order to minimize performance problems , it is recommended that you always clear one 
picture from the backdrop before specifying a new one. This prevents the system from having to deal 
with two large graphics files simultaneously.

Paste. Click this button to paste a .wmf or .bmp file from the clipboard into the current backdrop. You 
can also paste a graphic into an existing backdrop by selecting the backdrop on the screen and 
selecting the Paste command from the floating menu. Select the graphic file you want to paste into the 
backdrop and Click OK.

Browse. Click Browse to display a standard Open dialog box. Select the file to display and click OK. 
The pathname and file then appear in the File field and a preview of the graphic appears in the Picture 
control.

File. To add a picture to the backdrop, type the full path to the graphic file in the File field or press the 
Browse button to display an Open dialog box. When you specify a valid path, a preview of the graphic 
appears in the dialog box.

Embed. Select the Embed check box to save the picture file with the chart In order to save space, it is 
better not to embed charts unless they are not going to be available later.



Picture display box
This control displays a preview of the graphic. When you enter a valid path and file name into the File 
text box, or paste a graphic from the clipboard, the picture is previewed in the Picture control. Only the 
Windows Bitmap (.bmp) and Windows Metafiles (.wmf) graphic formats are supported.



Picture Fit radio buttons
Choose one of these options to determine how to fit the graphic into the backdrop space.

The following table lists the options for fitting graphics.

Constant Description
Actual Size Displays the graphic at the original size it was created. If the original size of the graphic is too

large , the graphic is cropped. If the original size of the graphic is too small, it is centered.

Best Fit Scales the graphic proportionally to fit entirely within the backdrop.

Stretch to Fit Scales the graphic to fit backdrop regardless of its original proportions.

Tiled Duplicates the graphic repeatedly to fill the backdrop.

Crop Fitted Centers the graphic and scales it proportionally to fill the backdrop. Any part of the image that
falls outside the backdrop is cropped.

Frame Section
Style. Select a frame style from the popup. 

Width. Enter the number of points to be used as the width for the frame lines. A point is 1/72 of an 
inch. For the Thick Inner and Thick Outer frames, the width sets the thick line. 

Color. Select a color for the frame lines from the Color picker.

Shadow. Select this check box to place a shadow on the frame. The following chart shows shadows 
around the chart control, plot, title, legend, and footnote.

Shadow Offset. Specify the number of points the shadow is offset from the frame.



The Format Plot Options Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The Options tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Type Tab 
The Format Plot Backdrop Tab 
The Format Plot 3D Lighting Tab 
The Format Plot Location Tab 
The Format Plot Order Tab 
The Format Plot 3D View Tab 
The Format Plot Base and Walls Tab 
The Format Plot Elevation Tab
The Format Plot Contouring Tab 



Bar Gap Ratio text box
Enter a bar gap value between 10,000 and -100. The default bar gap of 50 percent places a space 
between each bar that is half as wide as the bars. 



X Gap Ratio text box
Enter an x gap ratio to any value between 0 and 10,000. 



Z Gap Ratio text box
Enter a z gap value between 0 and 10,000.



Clockwise check box
Check this box to draw pie, doughnut, polar, and radar charts in a clockwise direction. Uncheck the box
to draw the charts in a counterclockwise direction.



Starting Angle text box
Enter a value between 0 and 360 degrees to indicate the point on a circle at which drawing starts for 
pie, doughnut, polar, and radar charts. Enter 0 to indicate the 3 oclock position. A starting angle of 90 
degrees moves the starting position to 12 oclock if the direction is set to counterclockwise, or to 6 
oclock if the direction is set to clockwise. The value is displayed in degrees, radians, or grad, 
depending on the setting in the Angle Units option. 



Scale Angle text box
Choose where you want to display the scale on the chart. Angles are measured in the direction 
specified by the Clockwise check box. A value of 0 starts at the 3 oclock position. 



Angle Units pop-up menu
Choose the unit of measure for all angles in the chart. This affects the unit of measure used for: 
drawing the angle (Y coordinate) in a polar chart; the starting angle for polar, pie and doughnut charts; 
scale angle for radar and polar charts; and the rotation and elevation of 3D charts. Choose degrees, 
radians, or grads.



Sorting list box
This setting controls the order in which the slices of pie and doughnut charts are drawn. The following 
table lists the options for this setting.

Setting Description
None Pie slices are drawn in the order the data appears in the data grid.

Ascending Pie slices are drawn from the smallest to the largest slice, starting at the defined starting angle.

Descending Pie slices are drawn from the largest to the smallest slice, starting at the defined starting angle.

Weighting list box
This setting controls the size of each pie or doughnut in relation to the other pies or doughnuts in the 
same chart. The following table lists the options for this setting.

Setting Description
None All pies and doughnuts are drawn the same size.

Pie Total The slice values in each pie are totaled and the pie with the highest total identified. The size of each pie in 
the chart is determined by the ratio of its total value compared to the largest pie. 

First Series The size of a pie is determined by the relationship of values in the first series of each pie. The larger the 
value in the first series, the bigger the pie. It is most common to exclude this first series so that the values 
are not drawn as pie slices.

Weighting Radio Buttons
Select the Area radio button to weight pies and doughnuts by the area of the chart element. Select the 
Diameter radio button to weight pies and doughnuts by the diameter of each chart element.



Thickness Ratio text box
This setting specifies the percentage of the pie or doughnut radius that determines the height of a 3D 
pie or doughnut. The higher the percentage, the taller the pie or doughnut. You can enter a value 
between 0 and 100 percent.



Top Radius Ratio text box
This setting specifies the percentage of the pie radius that is used to draw the top of a 3D pie. A ratio of
100 draws a cylinder; values less than 100 result in a tapering of the top of the pie. A value of 0 results 
in a cone.



Interior Ratio text box
This setting describes the ratio of the entire doughnut size that is used to display the interior "hole" of 
the doughnut. You can enter any number between 0 percent and 100 percent for this setting.



Sides text box
This setting controls the number of sides used to draw a doughnut. More sides give the doughnut a 
rounder, smoother appearance. If you enter a value of 1 in this option, First Impression determines the 
number of sides needed to draw a round doughnut based on the size of the doughnut. The maximum 
value for this option is 360. A very large number of sides may impact performance. 



Largest Bubble Ratio text box
This setting controls the appearance of bubbles in a bubble chart. It describes the percentage of the 
shortest chart axis that is used as the diameter of the largest bubble. All other values are then sized in 
their relationship to the largest bubble. Valid values for this option are 2 to 50.



Pie/Doughnut Label Position text box
This setting controls where the labels for each pie or doughnut are placed on the chart. These labels 
are actually category labels. They use the font and backdrops defined for the X axis labels. The 
following table lists the options for this setting.

Setting Description
None No label is displayed.

Above The label is displayed above the pie or doughnut.

Below The label is displayed below the pie or doughnut.

Center The label is centered on the pie or doughnut.

The Format Plot 3D Lighting Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The 3D Lighting tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Type Tab 
The Format Plot Backdrop Tab 
The Format Plot Options Tab 
The Format Plot Location Tab 
The Format Plot Order Tab 
The Format Plot 3D View Tab 
The Format Plot Base and Walls Tab 
The Format Plot Elevation Tab
The Format Plot Contouring Tab 



Ambient light text box
Check the box to turn ambient lighting on and then enter a number between 0 and 100 percent to 
specify the amount of ambient lighting to apply to the chart. 

If ambient light is set to 100 percent, all sides of the chart elements are illuminated equally no matter 
what light sources you turn on. If ambient light is set to 0, only the sides of chart elements facing the 
active light sources are illuminated. The default setting for ambient light is 15 percent.



Edge Intensity check box and text box
Check the box to turn edge lighting on. Uncheck the box to turn edge lighting off.Enter a number 
between 0 and 100 percent to specify the amount of lighting applied to the edges of 3D objects such as
bars, lines, pies or doughnuts. 

An edge light intensity of 0 draws the edges as black lines. An edge light intensity of 100 percent fully 
illuminates the edges using the edge pens color. The default edge pen color is the same as the series 
fill color.



Light sources text boxes
For each of the light sources, enter a value between 0 and 100 percent. At an intensity of 100 percent, 
chart surfaces perpendicular to the light source are fully illuminated. At an intensity of 50 percent, these
surfaces receive 50 percent illumination from this light. A setting of 0 turns off the light source.



The Format Plot Location Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The Location tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Type Tab 
The Format Plot Backdrop Tab 
The Format Plot Options Tab 
The Format Plot 3D Lighting Tab 
The Format Plot Order Tab 
The Format Plot 3D View Tab 
The Format Plot Base and Walls Tab 
The Format Plot Elevation Tab
The Format Plot Contouring Tab 



The Format Plot Order Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The Order tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Type Tab 
The Format Plot Backdrop Tab 
The Format Plot Options Tab 
The Format Plot 3D Lighting Tab 
The Format Plot Location Tab 
The Format Plot 3D View Tab 
The Format Plot Base and Walls Tab 
The Format Plot Elevation Tab
The Format Plot Contouring Tab 



Series Order list box
Select a series you wish to change the order of.



Up Button
Moves the selected series up one position in order.



Down Button
Moves the selected series down one position in order.



Stack Button
Stacks the selected series with the preceding series.



UnStack Button
Unstacks the selected stack associated with the series in the Series Order list.



The Format Plot 3D View Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The 3D View tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Type Tab 
The Format Plot Backdrop Tab 
The Format Plot Options Tab 
The Format Plot 3D Lighting Tab 
The Format Plot Location Tab 
The Format Plot Order Tab 
The Format Plot Base and Walls Tab 
The Format Plot Elevation Tab
The Format Plot Contouring Tab 



Elevation text box
Enter a number between 0 and 90 degrees in this control to describe the relative height from which a 
chart is viewed. If you set the elevation to 90, you look directly down on the top of the chart. If you set 
the elevation to 0, you look directly at the side of the chart. If you are using an angle measurement 
other than degrees, enter the proper equivalents. The default elevation is 30 degrees.



Rotation text box
Enter a number between 0 and 360 degrees to specify the angle that the chart is turned from the 
viewer. If you are using an angle measurement other than degrees, enter the proper equivalents. 
Rotation does not apply to 3D pie or doughnut charts.



Projection pop-up menu
Select a projection type from the popup menu. 

Projection Description
Oblique This is sometimes referred to as 2.5 dimensional. The chart has depth, but the XY plane does not change 

when the chart is rotated or elevated.

Orthogonal Perspective is not applied to the chart. The advantage of using this type of projection is that vertical lines 
remain vertical, making some charts easier to read.

Perspective This provides the most realistic 3D appearance. Objects farther away from you converge toward a vanishing
point.

Width to Height and Depth to Height Ratio text boxes
Enter the number representing the percentage of the charts height used to draw the charts width and 
depth.



Viewing Distance text box
Enter a positive number that represents the distance from which the chart is viewed as a percentage of
the depth of the chart.



The Format Plot Base and Walls Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The Base and Walls tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Type Tab 
The Format Plot Backdrop Tab 
The Format Plot Options Tab 
The Format Plot 3D Lighting Tab 
The Format Plot Location Tab 
The Format Plot Order Tab 
The Format Plot 3D View Tab 
The Format Plot Elevation Tab
The Format Plot Contouring Tab 



The Format Plot Contouring Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The Contouring tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Type Tab 
The Format Plot Backdrop Tab 
The Format Plot Options Tab 
The Format Plot 3D Lighting Tab 
The Format Plot Location Tab 
The Format Plot Order Tab 
The Format Plot 3D View Tab 
The Format Plot Base and Walls Tab 
The Format Plot Elevation Tab 



The Format Plot Elevation Tab
The options in the Format Plot dialog box control the location and appearance of the chart plot, 
formatting of 3D charts and formatting and ordering that affects all series or data points in the chart.

The Elevation tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Plot Type Tab 
The Format Plot Backdrop Tab 
The Format Plot Options Tab 
The Format Plot 3D Lighting Tab 
The Format Plot Location Tab 
The Format Plot Order Tab 
The Format Plot 3D View Tab 
The Format Plot Base and Walls Tab 
The Format Plot Contouring Tab 



Base Height text box
Enter the number of points for the base height.

This control only affects 3D charts.



Wall Width text box
Enter the number of points for the wall width.

This control only affects 3D charts.



Base Fill section
Use these controls to specify the colors and patterns used to draw the base of a chart.

The Base Fill is not used for a 2D chart.

Pattern. Click the control to display the pattern picker. Select one of the patterns, click None to have 
no pattern on the object, or click Solid to use only the fill color to fill the object. 

Fill Color and Pattern Color. Click any of these controls to display the Color Picker. Select one of the 
predefined colors or click Custom to mix your own color. 



Wall Fill section
Use these controls to specify the colors and patterns used to draw the walls of a chart.

Pattern. Click the control to display the pattern picker. Select one of the patterns, click None to have 
no pattern on the object, or click Solid to use only the fill color to fill the object. 

Fill Color and Pattern Color. Click any of these controls to display the Color Picker. Select one of the 
predefined colors or click Custom to mix your own color. 



Base Pen section
Use these controls to format the lines used to draw the base . The Base Pen is not used on 2D charts.

Style. Select a line style for the lines that frame the walls or base.

Width. Select a width for the lines that frame the walls or base; or, select Custom to specify your own 
line width.

Color. Click the control to display the Color Picker. Select one of the predefined colors to draw the 
lines that make up the base or walls; or, click Custom to mix your own color.



Wall Pen section
Use these controls to format the lines used to draw the wall edges.

Style. Select a line style for the lines that frame the walls or base.

Width. Select a width for the lines that frame the walls or base; or, select Custom to specify your own 
line width.

Color. Click the control to display the Color Picker. Select one of the predefined colors to draw the 
lines that make up the base or walls; or, click Custom to mix your own color.



The Format Series Options Tab
The Format Series dialog box controls the appearance of individual series in the chart. If you use the 
menu to display this dialog box, you are prompted to identify the series you want to format. 

The Options tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Fill Tab 
The Format Series Line Tab 
The Format Series Markers Tab 
The Format Series Statistics Tab 
The Format Series Guidelines Tab 



Hide series check box
Check this box to turn off display of the current series. The space occupied by the series is still shown 
on the chart, but the data is not displayed. Uncheck this box to redisplay a hidden series. In pie and 
doughnut charts, room is still reserved for hidden series pie slices, even though they are not displayed.



Exclude series check box
Check this box to remove a series from a chart. The data is not displayed and the space occupied by 
the series is removed from the chart. Uncheck this box to return an excluded series to the chart. 



Plot Series On 2nd Y Axis check box
Check this box to plot the current series on the secondary Y axis instead of the primary axis. You may 
then want to change the scale, type, or format of the secondary axis to best display the series data. 
Uncheck this box to plot the data on the primary axis.



Bar Sides text box
Enter a value between 1 and 360 to indicate the number of sides for the bars. If you enter 1, First 
Impression determines how many sides are necessary to create a round column, given the size of the 
bar. The following illustration shows a number of different bar styles that can be created by changing 
the number of sides.



Top Ratio text box
Enter a number between 0 and 10,000 to indicate the percent of the bottom diameter used to draw the 
top of the chart. Values less than 100 result in a top smaller than the bottom. Values greater than 100 
result in the top wider than the bottom. The following illustration shows the effects of changing the top 
ratio on several bars. 



Function list box
Select a smoothing type from the popup menu.The following table describes the smoothing type.

Smoothing Type Description
None No smoothing is applied to the data.

QuadraticBSpline A quadratic B-spline formula determines the smoothing applied to the data. This form of 
smoothing results in a less-smooth curve that stays closer to the data points.

CubicBSpline A cubic B-spline formula determines the smoothing applied to the data. This form of smoothing 
results in a smoother curve, but varies further from the data point than a QuadraticB spline 
curve.

Smoothing Factor text box
Specify the number of facets or points sampled between the chart data points to create the smoothing 
effect. The higher the number, the more smoothing occurs.



Gain Color color picker
Click the control to display the color picker and select the color used to indicate a gain in value. Select 
a predefined color or click Custom to mix your own color. Select Automatic to have all elements that 
reflect a gain in value use the fill color defined for the series.



Loss Color color picker
Click the control to display the color picker and select the color used to indicate a loss in value. Select 
a predefined color or click Custom to mix your own color. Select Automatic to have all elements that 
reflect a loss in value use the fill color defined for the series.



The Format Series Fill Tab
The Format Series dialog box controls the appearance of individual series in the chart. If you use the 
menu to display this dialog box, you are prompted to identify the series you want to format. 

The Fill tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Options Tab 
The Format Series Line Tab 
The Format Series Markers Tab 
The Format Series Statistics Tab 
The Format Series Guidelines Tab 



Series Fill Pattern picker
Click the control to display the pattern picker. Select the pattern or hatch you want to use to fill the 
chart element. The following illustration shows the organization of the pattern picker.



Series Fill Color picker
The fill color is used as the color for solid patterns. It is used as the background color for any other type
of pattern. By default, the line color for an element matches this fill color.



Series Pattern Color picker
The pattern color is used to draw the pattern over the fill color if any pattern other than solid is 
selected. 

For both color controls, click the control to display the color picker. Select the color you want to use. 
You can choose Custom to display a color mixer and create your own color.



Edge Pen Style list box
Click the control to display the line picker. The line picker displays the available line styles. Select the 
style you want to use to outline objects. 



Edge Pen Line Width list box
Click the control to display the available line widths. Select a width from the list or click Custom to 
specify your own width.



Edge Pen Color picker
Click the control to display the color picker. Select a predefined color, or select Automatic to have the 
outline drawn in the same color as the objects fill color. You can also click Custom to mix a new color.



Series Bar Picture Section
This control displays a preview of the graphic. When a valid path and file name are entered in the File 
text box, the picture is displayed in the Picture control. Only Windows Bitmap (.bmp) and Windows 
Metafiles (.wmf) are supported graphic formats.

Fit Method. You can choose how to fit the graphic into the bar. The following table lists the options for 
fitting graphics.

Fit Method Description
Stacked Duplicates the graphic repeatedly to fill the bars. Since this uses multiple copies of the graphic, it is 

recommended that you use as small a file as possible.

Stretch To Fit Scales the graphic to fit the bars regardless of its original proportions.

File. Type the full path to the graphic file in the File field or press the Browse button to display an Open 
File dialog box. When you specify a valid path, a preview of the graphic appears in the Picture control.



Clear Series Picture Button
Click this button to clear an existing picture from the picture control. 



Embed Series Picture Button
Select the Embed check box to save the graphic with the file.



Paste Series Picture Button
Click this button to place a .wmf or .bmp file from the clipboard into the current chart element. 



Browse Series Picture Button
Click this button to locate a .wmf or .bmp file to use as the picture.



The Format Series Line Tab
The Format Series dialog box controls the appearance of individual series in the chart. If you use the 
menu to display this dialog box, you are prompted to identify the series you want to format. 

The Line tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Options Tab 
The Format Series Fill Tab 
The Format Series Markers Tab 
The Format Series Statistics Tab 
The Format Series Guidelines Tab 



Show Series Lines check box
Check this check box to display lines on a 2D chart. Uncheck this check box to hide the lines on the 
chart. 



Series Line Style list box
Click the control to select a style for the current line.



Series Line Width list box
Click the control to display the preset line widths. Pick a width, or select Custom to assign your own 
width.



Series Line Color picker
Click the control to display the Color picker. Select one of the predefined colors, or click Custom to mix 
your own color.



Series Line Join style list box
Select a method of joining line segments in the series. Join styles are particularly important when using
thick lines. 

Join Types Description
Mitered The outer edges of the two lines are extended until they meet.

Round A circular arc is drawn around the point where the two lines meet.

Beveled The notch between the ends of two joining lines is filled.

Important       Very acute mitered joins are automatically beveled to avoid drawing large spikes along 
the line.



Series Line Cap style list box
Select a type to specify how the ends of lines are displayed.

Cap Type Description
Butt The line is squared off at the endpoint.

Round A semicircle with a diameter of the line thickness is drawn at the end of the line.

Squared The line continues beyond the endpoint for a distance equal to half the line thickness and is squared 
off.

The Format Series Markers Tab
The Format Series dialog box controls the appearance of individual series in the chart. If you use the 
menu to display this dialog box, you are prompted to identify the series you want to format. 

The Markers tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Options Tab 
The Format Series Fill Tab 
The Format Series Line Tab 
The Format Series Statistics Tab 
The Format Series Guidelines Tab 



Show Series Markers check box
Check this box to display markers on a series. Uncheck this box to remove markers from a series.



Series Markers Automatic check box 
Check this box to allow First Impression to use the next available marker to identify the series. 
Uncheck this box to select your own choice of marker.



Series Markers Style list box
Select a marker type to identify the data points in the current series. 



Series Markers Color picker
Click the control to display the Color Picker. Select a color for the marker or click Custom and mix your 
own color.



Series Markers Size text box
Enter the number of points for the marker diameter.



Series Markers Pen Width list box
Select a width for the lines that form the marker, or click Custom and set your own width.



The Format Series Statistics Tab
The Format Series dialog box controls the appearance of individual series in the chart. If you use the 
menu to display this dialog box, you are prompted to identify the series you want to format. 

The Statistics tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Options Tab 
The Format Series Fill Tab 
The Format Series Line Tab 
The Format Series Markers Tab 
The Format Series Guidelines Tab 



Show Statistics Lines check boxes
For each type of statistic, check the box to display the line or uncheck the box to remove the line. The 
following table describes each type of statistic.

Statistic Type Description
Minimum Shows the minimum Y value in the series.

Maximum Shows the maximum Y value in the series.

Mean Shows the mathematical mean of the Y values in the series.

Standard Deviation Shows the standard deviation of the Y values in the series.

Regression Shows a trend line indicated by the Y values in a series.

Statistics Line Styles list boxes
For each type of statistic, select a line style that uniquely identifies it.



Statistics Line Color picker
Select the color for the statistics lines that represent the current series.



Statistics Line Width list box
Select a width for the statistics lines, or click custom and set a new width. 



The Format Series Guidelines Tab
The Format Series dialog box controls the appearance of individual series in the chart. If you use the 
menu to display this dialog box, you are prompted to identify the series you want to format. 

The Guidelines tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Options Tab 
The Format Series Fill Tab 
The Format Series Line Tab 
The Format Series Markers Tab 
The Format Series Statistics Tab 



Show Guidelines check box
Check this box to display guidelines for the series. Uncheck this box to remove guidelines.



Guideline Styles list boxes
Select a Guideline style from the list of predefined styles.



Guideline Color picker
Select the color for the guideline.



Guideline Width list box
Select a width for the guideline, or click custom and set a new width. 



Guidelines Cap style list box
Select a type to specify how the ends of guidelines are displayed.

Cap Type Description
Butt The line is squared off at the endpoint.

Round A semicircle with a diameter of the line thickness is drawn at the end of the line.

Squared The line continues beyond the endpoint for a distance equal to half the line thickness and is squared 
off.

The Format Series Label Options Tab
The Format Series Label dialog box controls the display and appearance of series labels on area, step,
and line charts.

The Options tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Label Font Tab 
The Format Series Label Text Tab 
The Format Series Label Backdrop Tab 



Series Label Location radio buttons
To display a series label on the chart, select one of the predefined positions. The following table 
describes the valid positions for series labels.

Positions Description
None Hides the label.

First The label is displayed above the first data point in the series.

Last The label is displayed above the last data point in the series.

Center The label is displayed above the middle data point in the series.

Series Label Line Style radio buttons
To display a line connecting a label to a series it represents, select one of the Label Line Style radio 
buttons described in the following table.

Line Styles Description
None No line connects the label and series.

Line A straight line connects the label and series.

Angle Line An angled line connects the label and series.

The Format Series Label Font Tab
The Format Series Label dialog box controls the display and appearance of series labels on area, step,
and line charts.

The Font tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Label Options Tab 
The Format Series Label Text Tab 
The Format Series Label Backdrop Tab 





The Format Series Label Text Tab
The Format Series Label dialog box controls the display and appearance of series labels on area, step,
and line charts.

The Text tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Label Options Tab 
The Format Series Label Font Tab 
The Format Series Label Backdrop Tab 



The Format Series Label Backdrop Tab
The Format Series Label dialog box controls the display and appearance of series labels on area, step,
and line charts.

The Backdrop tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Series Label Options Tab 
The Format Series Label Font Tab 
The Format Series Label Text Tab 



The Format Data Point Options Tab
The Format Data Point dialog box is used to format the appearance of an individual data point. If you 
use the menu to display this dialog, you are prompted to identify which data point you want to format. 

The Options tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Data Point Fill Tab 
The Format Data Point Markers Tab 



Use Series Defaults check box 
Uncheck this box to ungray the Fill and Markers tabs. You can then change any of the Fill or Marker 
options used to display the data point. Check the Use Series Defaults check box to discard any custom
settings you have made for the data point and reset all options to the series defaults.



The Format Data Point Fill Tab
The Format Data Point dialog box is used to format the appearance of an individual data point. If you 
use the menu to display this dialog, you are prompted to identify which data point you want to format. 

The Fill tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Data Point Options Tab 
The Format Data Point Markers Tab 



DataPoint Fill Pattern picker
Click the control to display the pattern picker. Select the pattern or hatch you want to use to fill the 
chart element. The following illustration shows the organization of the pattern picker.



Data Point Fill Color picker
The fill color is used as the color for solid patterns. It is used as the background color for any other type
of pattern. By default, the line color for an element matches this fill color.



Data Point Pattern Color picker
The pattern color is used to draw the pattern over the fill color if any pattern other than solid is 
selected. 

For both color controls, click the control to display the color picker. Select the color you want to use. 
You can choose Custom to display a color mixer and create your own color.



Data Point Picture Section 
This control displays a preview of the graphic. When a valid path and file name are entered in the File 
text box, the picture is displayed in the Picture control. Only Windows Bitmap (.bmp) and Windows 
Metafiles (.wmf) are supported graphic formats.

Fit Method. You can choose how to fit the graphic into the data point. The following table lists the 
options for fitting graphics.

Fit Method Description
Stacked Duplicates the graphic repeatedly to fill the data point. Since this uses multiple copies of the graphic, it 

is recommended that you use as small a file as possible.

Stretch To Fit Scales the graphic to fit the data point regardless of its original proportions.

File. Type the full path to the graphic file in the File field or press the Browse button to display an Open 
File dialog box. When you specify a valid path, a preview of the graphic appears in the Picture control.



Clear Data Point Picture Button
Click this button to clear an existing picture from the picture control. 



Embed Data Point Picture Button
Select the Embed check box to save the graphic with the file.



Paste Data Point Picture Button
Click this button to place a .wmf or .bmp file from the clipboard into the current chart element. 



Browse Data Point Picture Button
Click this button to locate a .wmf or .bmp file to use as the picture.



The Format Data Point Markers Tab
The Format Data Point dialog box is used to format the appearance of an individual data point. If you 
use the menu to display this dialog, you are prompted to identify which data point you want to format. 

The Markers tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Data Point Options Tab 
The Format Data Point Fill Tab 



Show Data Point Markers check box
Check this box to display markers on a data point. Uncheck this box to remove markers from a data 
point.



Data Point Markers Automatic check box 
Check this box to allow First Impression to use the next available marker to identify the data point. 
Uncheck this box to select your own choice of marker.



Data Point Markers Style list box
Select a marker type to identify the data points in the current series. 



Data Point Markers Color picker
Click the control to display the Color Picker. Select a color for the marker or click Custom and mix your 
own color.



Data Point Markers Size text box
Enter the number of points for the marker diameter.



Data Point Markers Pen Width list box
Select a width for the lines that form the marker, or click Custom and set your own width.



The Format Data Point Label Options Tab
The Format Data Point Label dialog box controls the text or value used to label a data point, as well as 
the font, format, position and backdrop used to display the label.

The Options tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Data Point Label Text Tab 
The Format Data Point Label Font Tab 
The Format Data Point Label Backdrop Tab 
The Format Data Point Label Value Format Tab 
The Format Data Point Label Percent Format Tab 



Data Point Label Location radio buttons
Choose one of nine preset locations to position data point labels. The following table lists the available 
locations..

Locations Description
None No label displayed.

Above Point The label is displayed above the data point. This location is only valid for bar, line, area, step, XY, polar, 
radar, and bubble charts.

Below Point The label is displayed below the data point. This location is only valid for bar, line, area, step, XY, polar, 
radar, and bubble charts.

Center The label is displayed centered on the data point. This location is only valid for bar, line, area, and step 
charts.

Base The label is displayed along the category axis, directly beneath the data point. This location is only valid for 
bar, line, area, and step charts.

Inside The label is displayed inside a pie or doughnut slice.

Outside The label is displayed outside a pie or doughnut slice.

Left The label is displayed to the left of the data point. This location is only valid for XY, polar, radar, and bubble 
charts.

Right The label is displayed to the right of the data point. This location is only valid for XY, polar, radar, and 
bubble charts.

Data Point Label Line Styles radio buttons
Choose one of the available line styles from the list box. The following table lists the valid label line 
styles. 

Line Styles Description
None No line connects the label and series.

Line A straight line connects the label and data point.

Angle line An angled line connects the label and data point.



The Format Data Point Label Text Tab
The Format Data Point Label dialog box controls the text or value used to label a data point, as well as 
the font, format, position and backdrop used to display the label.

The Text tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Data Point Label Options Tab 
The Format Data Point Label Font Tab 
The Format Data Point Label Backdrop Tab 
The Format Data Point Label Value Format Tab 
The Format Data Point Label Percent Format Tab 



Automatic Data Point Label radio button
Select a label from the available label types. The label types are described in the following table. If you 
select more than one type, the labels are stacked on top of each other.

Type Description
Value The value of the data point appears in the label.

Percent The value of the data point is displayed in the label as a percentage according to the axis percent 
basis.

Series Name The series name is used to label the data point. 

Data Point Name The category name is used to label the data point. 

Custom Data Point Label radio button
Select this radio button to enter custom label text in the Text field. 



Custom Data Point Label Text box
Enter the custom label text in this field. 

Use CTRL + ENTER to force text to another line. 



The Format Data Point Label Font Tab
The Format Data Point Label dialog box controls the text or value used to label a data point, as well as 
the font, format, position and backdrop used to display the label.

The Font tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Data Point Label Options Tab 
The Format Data Point Label Text Tab 
The Format Data Point Label Backdrop Tab 
The Format Data Point Label Value Format Tab 
The Format Data Point Label Percent Format Tab 



The Format Data Point Label Backdrop Tab
The Format Data Point Label dialog box controls the text or value used to label a data point, as well as 
the font, format, position and backdrop used to display the label.

The Backdrop tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Data Point Label Options Tab 
The Format Data Point Label Text Tab 
The Format Data Point Label Font Tab 
The Format Data Point Label Value Format Tab 
The Format Data Point Label Percent Format Tab 



The Format Data Point Label Value Format Tab
The Format Data Point Label dialog box controls the text or value used to label a data point, as well as 
the font, format, position and backdrop used to display the label.

The Value Format tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Data Point Label Options Tab 
The Format Data Point Label Text Tab 
The Format Data Point Label Font Tab 
The Format Data Point Label Backdrop Tab 
The Format Data Point Label Percent Format Tab 



Value Format Category list box
Select a category to display a list of preset format strings appropriate for that type of data in the Format
Code list box.



Value Format Code list box
Select one of the predefined strings. 



Custom Value Code text box
Enter valid format symbols in this field to create your own custom format.



The Format Data Point Label Percent Format Tab
The Format Data Point Label dialog box controls the text or value used to label a data point, as well as 
the font, format, position and backdrop used to display the label.

The Percent Format tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Data Point Label Options Tab 
The Format Data Point Label Text Tab 
The Format Data Point Label Font Tab 
The Format Data Point Label Backdrop Tab 
The Format Data Point Label Value Format Tab 



Percent Format Category list box
Select a category to display a list of preset format strings appropriate for that type of data in the Format
Code list box.



Percent Format Code list box
Select one of the predefined strings. 



Custom Percent Code text box
Enter valid format symbols in this field to create your own custom format.



The Format Axis Options Tab
The Format Axis dialog box controls the display of various axes, the scale of various types of axes, and
the appearance of the axis grid and axis ticks.

The Options tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Grid Tab 
The Format Axis Scale-Category Tab 
The Format Axis Scale-Date Tab 
The Format Axis Scale-Value Tab 
The Format Axis Polar Tab 
The Format Axis Radar Tab 
The Format Axis Ticks Tab 



Pen Width pop up menu
Select a predefined width from the list, or click Custom to assign your own width.



Pen Color pop up menu
Click the control to display the Color Picker. Select a predefined color, or click Custom to mix your own 
color.



The Format Axis Grid Tab
The Format Axis dialog box controls the display of various axes, the scale of various types of axes, and
the appearance of the axis grid and axis ticks.

The Grid tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Options Tab 
The Format Axis Scale-Category Tab 
The Format Axis Scale-Date Tab 
The Format Axis Scale-Value Tab 
The Format Axis Polar Tab 
The Format Axis Radar Tab 
The Format Axis Ticks Tab 



Width pop up
Select a predefined width from the list or click Custom to design your own width. The following 
illustration shows how grid width can be used to change the appearance of a chart.



Style pop up
Select a line style from the list. The following table shows an example of each line style. 



Color pop up
Click the control to display the Color Picker. Select a predefined color, or click Custom to mix your own 
color.



The Format Axis Scale-Category Tab
The Format Axis dialog box controls the display of various axes, the scale of various types of axes, and
the appearance of the axis grid and axis ticks.

The Scale tab displays the following options if the selected axis is a category axis.:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Options Tab 
The Format Axis Grid Tab 
The Format Axis Scale-Date Tab 
The Format Axis Scale-Value Tab 
The Format Axis Polar Tab 
The Format Axis Radar Tab 
The Format Axis Ticks Tab 



Show Scale check box
Check this box to display the axis scale, line, ticks, and title on the axis. Uncheck the box to hide the 
axis elements. 



Automatic Scale check box
Check this box to let First Impression scale the axis based on the data being charted. Uncheck this box
to manually scale the axis based on values you provide in the Divisions Per Label and Divisions per 
Tick options.



Divisions Per Label text box
A value of 1 labels every division. A value greater than 1 labels the first division and skips the labels for 
the extra divisions.



Divisions Per Tick text box
A value of 1 places a tick mark at every division. A value greater than 1 places a tick mark at the first 
division and skips the tick marks for the extra divisions.



Labels On Tick Marks check box
Check this box to center each label on a tick mark. Uncheck this box to center each label between two 
tick marks.



Automatic Axis Intersection check box
Check this box to have the axes intersect at their usual position. Uncheck this box to enable the Cross 
At and Labels Inside Plot options to specify where you want the current axis to intersect a 
perpendicular axis.



Cross At text box
Enter the position where you want the current axis to cross its intersecting axis. If the intersecting axis 
is a value axis, enter the value where you want to place the current axis. If the intersecting axis is a 
date or category axis, enter the division number at which you want to place the current axis. 



Labels Inside Plot check box
Check this box to move the axis labels with the axis to the new intersection point. This may cause 
labels to display on top of the chart plot. Uncheck this box to leave the labels in their original 
position.Only the axis line and tick marks are drawn at the new intersection point.



The Format Axis Scale-Date Tab
The Format Axis dialog box controls the display of various axes, the scale of various types of axes, and
the appearance of the axis grid and axis ticks.

The Scale tab displays the following options if the selected axis is a Date axis:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Options Tab 
The Format Axis Grid Tab 
The Format Axis Scale-Category Tab 
The Format Axis Scale-Value Tab 
The Format Axis Polar Tab 
The Format Axis Radar Tab 
The Format Axis Ticks Tab 



Show Date Scale check box
Check this box to display the axis scale, line, ticks, and title on the axis. Uncheck the box to hide the 
axis elements.



Automatic Date Scale check box
Check this box to let First Impression scale the axis based on the minimum and maximum values in the
data being charted. Uncheck this box to manually scale the axis based on values you provide.

Minimum Enter the lowest or beginning date for the axis.

Maximum. Enter the highest or ending date for the axis scale.

Major Interval and Minor Interval. For each of these intervals, enter a number to specify how many 
intervals pass before a tick mark is placed on the axis. Then, select an interval type from the list box.    
The following table describes the interval settings:

Type Description
None No Interval.

Days A tick mark occurs each day.

Weeks A tick mark occurs Monday of each week.

Semi-months A tick mark occurs on the 1st and 15th day of each month.

Months A tick mark occurs on the 1st of each month.

Years A tick mark occurs on January 1 of each year.

Major Format. Select a date format to display the first level of axis labels.

You can add additional levels of labels to indicate month and year changes on the data axis. 

New Month. Select a format to be used to indicate a change of month. 

New Year. Select a format to be used to indicate a change of year.



Date Axis Intersection Automatic check box
Check this box to have the axes intersect at their usual position. Uncheck this box to enable the Cross 
At and Labels Inside Plot options to specify where you want the current axis to cross an intersecting 
axis.



Date Axis Intersection Cross At check box
Enter the position where you want the current axis to cross an intersecting axis. If the intersecting axis 
is a value axis, enter the value where you want to place the current axis. If the intersecting axis is a 
date or category axis, enter the division number at which you want to place the current axis. 



Date Axis Labels Inside Plot check box
If you enter a value in the Axis Intersection option, this check box is enabled. Check this box to move 
the axis labels with the axis to the new intersection point. This may cause labels to display on top of the
chart plot. Uncheck this box to leave the labels in their original position.



Skip Weekends check box
Check this box to not display dates that fall on weekends. Uncheck this box to display all dates 
regardless of day of the week.



The Format Axis Scale-Value Tab
The Format Axis dialog box controls the display of various axes, the scale of various types of axes, and
the appearance of the axis grid and axis ticks.

The Scale tab displays the following options if the selected axis is a Value axis:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Options Tab 
The Format Axis Grid Tab 
The Format Axis Scale-Category Tab 
The Format Axis Scale-Date Tab 
The Format Axis Polar Tab 
The Format Axis Radar Tab 
The Format Axis Ticks Tab 



Automatic Value Axis Scale
Check this box to let First Impression scale the axis based on theminimum and maximum values in the 
dat being charted.Uncheck this box to manually scale the axis based onvalues you provide.

If you uncheck the Automatic Scale check box, the following four options are enabled so that you can 
enter values to be used to scale the axis.

Minimum Enter the lowest or beginning value for the scale.

Maximum Enter the highest or ending value for the scale.

Major Divisions Enter the number of major divisions you want on the axis. Axis labels are only 
displayed on major divisions.

Minor Divisions Enter the number of minor divisions you want between each maor division of the axis.



The Format Axis Scale Tab (3D XYZ)
The Format Axis dialog box controls the display of various axes, the scale of various types of axes, and
the appearance of the axis grid and axis ticks.

The Scale Tab displays the following options if the chart type is 3D XYZ:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Options Tab 
The Format Axis Grid Tab 
The Format Axis Scale-Category Tab 
The Format Axis Scale-Date Tab 
The Format Axis Scale-Value Tab 
The Format Axis Polar Tab 
The Format Axis Radar Tab 
The Format Axis Ticks Tab 



Automatic 3D Axis Intersection check box
Check this box to have the axes intersect at their usual position. Uncheck this box to enable the Cross 
At options to specify where you want the current axis to cross the intersecting axis.



X Axis text box
Enter the point on the X value axis where you want the Y and Z axes to intersect.



Y Axis text box
Enter the point on the Y value axis where you want the X and Z axes to intersect.



Z Axis text box
Enter the point on the Z value axis where you want the X and Y axes to intersect.



XYZ Show Scale check box
Check this box to display the axis scale, line, ticks, and title on the axis. Uncheck the box to hide the 
axis elements. 



XYZ Automatic Scale.check box
Check this box to let First Impression scale the axis based on the minimum and maximum values in the
data being charted. Uncheck this box to manually scale the axis based on values you provide. 

If you uncheck the Automatic Scale check box, the following four options are enabled so that you can 
enter values to be used to scale the axis.

Minimum. Enter the lowest or beginning value for the scale.

Maximum. Enter the highest or ending value for the scale.

Major Divisions. Enter the number of major divisions you want on the axis. Axis labels are only 
displayed on major divisions.

Minor Divisions. Enter the number of minor divisions you want between each major division of the 
axis.



Type pop up menu
Select the type of scale you want to use on the axis. The following table describes the types of axis 
scaling

Type Description
Linear Data points are plotted in a linear scale with values ranging from the minimum to the maximum chart value. 

This is the default scale type.

Logarithmic Data points are plotted in a logarithmic scale with values based on a specific log scale. Logarithmic axes are
not appropriate for zero or negative data.

Percent Data points are plotted in a linear scale as percentages of the chart values. Changing the percent basis of a 
chart is useful for determining overall trends in data rather than specific values.

Log Base text box
Enter the logarithm base to be used for a logarithmic scale axis. 

The default base is 10.



Percent Basis pop up menu
If you select Percent as the axis type, you can choose one of the following methods of calculating the 
percentages.

Percentage Type Description
Chart Maximum The largest value in the chart is considered 100 percent and all other values on the chart are 

displayed as percentages of that value.

Category Maximum The largest value in each category is considered 100 percent and all other values in that category 
are displayed as percentages of that value.

Series Maximum The largest value in each series is considered 100 percent and all other values in that series are 
displayed as percentages of that value.

Chart Total All values in the chart are added together, and that value is considered 100 percent. All values in the
chart are displayed as percentages of that value.

Category Total All values in each category are added together to give a total value for each category. All values are 
displayed as a percentage of their category total. 

Series Total All values in each series are added together to give a total value for each series. All values are 
displayed as a percentage of their series total. 

Uniform Axes check box
Check this box to specify that the unit scale for all value axes in the current chart is uniform.



The Format Axis Polar Tab
The Format Axis dialog box controls the display of various axes, the scale of various types of axes, and
the appearance of the axis grid and axis ticks.

The Polar tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Options Tab 
The Format Axis Grid Tab 
The Format Axis Scale-Category Tab 
The Format Axis Scale-Date Tab 
The Format Axis Scale-Value Tab 
The Format Axis Radar Tab 
The Format Axis Ticks Tab 



Polar Axis Automatic Scale
Check this box to let First Impression scale the axis based on the data being charted. Uncheck this box
to manually scale the axis based on values you provide. 

If you uncheck the Automatic Scale check box, the following four options are enabled so that you can 
enter values to be used to scale the axis.

Major Divisions    Enter the number of major divisions you want on the axis. Radial grid lines for major 
divisions extend to the center of the chart.

Minor Divisions    Enter the number of minor divisions you want between each major division of the 
axis. Radial grid lines for minor divisions extend from the first division of the value axis to the perimeter 
of the chart.



The Format Axis Radar Tab
The Format Axis dialog box controls the display of various axes, the scale of various types of axes, and
the appearance of the axis grid and axis ticks.

The only option available on the Radar tab is to turn on or off the Show Scale tab. Unchecking the 
Show Scale check box turns off the category labels at the end of each value axis.

Click on the check box of this tab to learn what it does.
See Also:
The Format Axis Options Tab 
The Format Axis Grid Tab 
The Format Axis Scale-Category Tab 
The Format Axis Scale-Date Tab 
The Format Axis Scale-Value Tab 
The Format Axis Polar Tab 
The Format Axis Ticks Tab 



The Format Axis Ticks Tab
The Format Axis dialog box controls the display of various axes, the scale of various types of axes, and
the appearance of the axis grid and axis ticks.

The Ticks tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Options Tab 
The Format Axis Grid Tab 
The Format Axis Scale-Category Tab 
The Format Axis Scale-Date Tab 
The Format Axis Scale-Value Tab 
The Format Axis Polar Tab 
The Format Axis Radar Tab 



Axis Tick Length text box
Enter the length of the major tick marks in points. Minor tick marks are drawn at half this length.



Axis Tick Location radio buttons
Select a style to specify the position of the tick on the axis.The following table lists the available tick 
position settings. 

Style Description
None No tick marks are displayed on the axis. 

Center Tick marks are centered across the axis.

Inside Tick marks are displayed inside the axis.

Outside Tick marks are displayed outside the axis.

The Format Axis Label Backdrop Tab
The Format Axis Label dialog box controls the position of axis labels, and the backdrop, font, and 
format used to display them. If you use the menu to display this dialog, you are prompted to specify 
which axis you want to format.

The Backdrop tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Label Text Tab 
The Format Axis Label Font Tab 
The Format Axis Label Format Code Tab 



The Format Axis Label Text Tab
The Format Axis Label dialog box controls the position of axis labels, and the backdrop, font, and 
format used to display them. If you use the menu to display this dialog, you are prompted to specify 
which axis you want to format.

The Text tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Label Backdrop Tab 
The Format Axis Label Font Tab 
The Format Axis Label Format Code Tab 



Label Automatic check box
Check this box to allow First Impression to rotate the labels if necessary to optimize the chart layout. 
Uncheck this box to set a specific horizontal and vertical alignment and orientation for the label text.



Standing Labels check box
On 3D charts, check this box to rotate labels up on the text baseline to stand in the Y plane. Standing 
text can make the labels more legible if you are viewing the chart at very low elevations. This option 
applies only to labels on an X or Z axis on most charts, and the Y axis on horizontal charts.. Uncheck 
this box to return labels to their standard position in the X or Z plane.



The Format Axis Label Font Tab
The Format Axis Label dialog box controls the position of axis labels, and the backdrop, font, and 
format used to display them. If you use the menu to display this dialog, you are prompted to specify 
which axis you want to format.

The Font tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Label Backdrop Tab 
The Format Axis Label Text Tab 
The Format Axis Label Format Code Tab 



The Format Axis Label Format Code Tab
The Format Axis Label dialog box controls the position of axis labels, and the backdrop, font, and 
format used to display them. If you use the menu to display this dialog, you are prompted to specify 
which axis you want to format.

The Format Code tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
Click here to view sample Number Formats
Click here to view sample Date and Time Formats.
Click here to view the codes available to use when designing Custom Label Formats.
See Also:
The Format Axis Label Backdrop Tab 
The Format Axis Label Text Tab 
The Format Axis Label Font Tab 



Axis Label Category pop up menu
Select a category to display a list of preset format strings appropriate for the type of label in the Format
Codes list box.



Axis Label Format Code pop up menu
Select one of the predefined strings. 



Custom Axis Label text field
Enter valid format symbols in this field to create your own custom format.You can also create a custom 
format. The following table lists the format symbols that can be used in a custom format string.



The Format Axis Title Text Tab
The Format Axis Title dialog box controls the text used as a title for the axis chart. It also controls the 
font and backdrop used to display the title. If you use the menu to display this dialog, you are prompted
to specify which axis you want to format.

The Text tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Title Backdrop Tab 
The Format Axis Title Font Tab 



Axis Title Visible check box
Check this box to display the axis title. Uncheck this box to hide the axis title.

The Horizontal, Vertical, and Orientation sections of the dialog box are enabled if you uncheck the 
Visible check box. 

Axis Title Word Wrap check box

Check this box to wrap any text that is too long to fit on one line of the bounding box. You can also 
control where text breaks by pressing CTRL + ENTER to place a soft carriage return in the text. 

Axis Title Text box

Enter the title text.



The Format Axis Title Backdrop Tab
The Format Axis Title dialog box controls the text used as a title for the axis chart. It also controls the 
font and backdrop used to display the title. If you use the menu to display this dialog, you are prompted
to specify which axis you want to format.

The Backdrop tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Title Text Tab 
The Format Axis Title Font Tab 



The Format Axis Title Font Tab
The Format Axis Title dialog box controls the text used as a title for the axis chart. It also controls the 
font and backdrop used to display the title. If you use the menu to display this dialog, you are prompted
to specify which axis you want to format.

The Font tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Axis Title Text Tab 
The Format Axis Title Backdrop Tab 



The Format Legend Backdrop Tab
The Format Legend dialog box controls the positioning and appearance of the chart legend.

The Backdrop tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Legend Font Tab 
The Format Legend Location Tab 



The Format Legend Font Tab
The Format Legend dialog box controls the positioning and appearance of the chart legend.

The Font Tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Legend Backdrop Tab 
The Format Legend Location Tab 



Font list box
Select a font from the list of fonts installed on your Windows system.



Font Style list box
Select a style from the list of supported styles for the font you selected.



Size list box
Select a size from the list of valid sizes for the font you selected. You can also type a valid size in the 
Size field.



Effects check box
Check either or both the Strikeout and Underline check boxes to apply those effects to the text.



Sample display box
As you make selections from the other controls in this dialog box, the sample is updated to reflect the 
changes.



Color pop up menu
Click the control to display the Color Picker. Select one of the predefined colors, or click Custom to mix 
your own color.



The Format Legend Location Tab
The Format Legend dialog box controls the positioning and appearance of the chart legend.

The Location tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Legend Backdrop Tab 
The Format Legend Font Tab 



Visible check box
Click here to display the chart element.



Location radio buttons
Click on one of these buttons to position the chart element.



Custom Location check box and text boxes
Click here to manually enter a custom location for the chart element, then enter the appropriate value 
for the following location settings:

Top:      The top of the chart element.

Left:      The left edge of the chart element.

Height:     The height of the chart element.

Width:     The width of the chart element.



Custom Location radio button and text boxes
Click here to manually enter a custom location for the chart element, then enter the appropriate value 
for the following location settings:

Top:      The top of the chart element.

Left:      The left edge of the chart element.

Height:     The height of the chart element.

Width:     The width of the chart element.



The Format Title Location Tab
The Format Title dialog box controls the positioning and appearance of the chart title.

The Location tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Title Text Tab 
The Format Title Backdrop Tab 
The Format Title Font Tab 



The Format Title Text Tab
The Format Title dialog box controls the positioning and appearance of the chart title.

The Text Tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Title Location Tab 
The Format Title Backdrop Tab 
The Format Title Font Tab 



Horizontal Alignment radio buttons
Click the appropriate radio button to align text horizontally.

The following table describes the horizontal alignment options for text. 

Alignment Description
Left All lines of text are aligned on the left margin.

Right All lines of text are aligned on the right margin.

Center All lines of text are centered horizontally.

Vertical Alignment radio buttons
Click the appropriate radio button to align text vertically.

The following table describes the vertical alignment options for text.

Alignment Description
Top All lines of text are aligned at the top margin.

Bottom All lines of text are aligned at the bottom margin.

Center All lines of text are centered vertically.

Orientation radio buttons
Click the appropriate radio button to set the desired orientation options.

The following table describes the orientation options for text.

Orientation Description
Horizontal The text is displayed horizontally.

Vertical The text is displayed, one letter on top of each other, reading from 
top to bottom.

Up The text is rotated to read from bottom to top.

Down The text is rotated to read from top to bottom.

Note       When you rotate text up or down, the vertical and horizontal alignment are still relative to the 
text and not to the bounding box. In other words, text displayed with up orientation and left alignment is
actually flush against the bottom of the bounding box, not the left side.



Word Wrap check box
Check this box to wrap any text that is too long to fit on one line of the bounding box. You can also 
insert line breaks manually by pressing CTRL + ENTER anywhere in the text. Word Wrap is not 
available on the Text tab of the following dialog boxes: Format Axis Labels, Format Data Point Labels, 
and Format Series Labels.



Text box
Enter the text to be displayed by the chart element you are formatting.



The Format Footnote Location Tab
The Format Footnote Location tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Footnote Backdrop Tab 
The Format Footnote Font Tab 
The Format Footnote Text Tab 



The Format Footnote Backdrop Tab
The Format Footnote Backdrop tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Footnote Location Tab 
The Format Footnote Font Tab 
The Format Footnote Text Tab 



The Format Footnote Font Tab
The Format Footnote Font tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Footnote Location Tab 
The Format Footnote Backdrop Tab 
The Format Footnote Text Tab 



The Format Title Backdrop Tab
The Format Title Backdrop tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Title Location Tab 
The Format Title Text Tab 
The Format Title Font Tab 



The Format Title Font Tab
The Format Title Font tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Title Location Tab 
The Format Title Text Tab 
The Format Title Backdrop Tab 



The Format Footnote Text Tab
The Format Footnote Text tab displays the following options:

Click on the buttons, check boxes and text boxes of this tab to learn what they do.
See Also:
The Format Footnote Location Tab 
The Format Footnote Backdrop Tab 
The Format Footnote Font Tab 



Contour list box
To specify how contours are displayed, select one of the following options:

Type Description
Bands Contours are displayed as bands of color.

Lines Contours are displayed as colored lines.

Base list box
This option controls how the base of a surface chart is represented. Select one of the following options:

Type Description
Pedestal The base is displayed as a solid area that rises up to meet the surface.

Standard The base is displayed as a flat area beneath the chart surface.

Bands The base reflects the charts contours as a series of contour bands.

Lines The base reflects the charts contours as a series of contour lines.

Projection list box
This option displays a planar contour chart projected above a surface chart. Select one of the following 
projection methods:

Method Description
None No projection is displayed above the chart.

Bands The planar chart reflects the charts contours in contour bands.

Lines The planar chart reflects the charts contours in contour lines.

Surface list box
This option controls how the surface itself is represented on a 3D surface chart. Select one of the 
following options:

Type Description
 None The surface data is represented exclusively by a wireframe.

Bands The surface displays changes in data with contour bands.

Lines The surface is represented by a wireframe and displays changes in data with contour lines.

Solid The surface is drawn with a solid color.

Solid with Lines The surface is drawn with a solid color. Changes in data are indicated by contour lines super imposed 
on the solid color.

Wireframe list box
This wireframe option controls the appearance of the wireframe drawn upon a surface chart. Select 
one of the following options:

Type Description
 None The surface is represented by the surface color only.

Major The wireframe indicates the original data grid values.



Major and Minor The wireframe is drawn upon the surface along the original data grid values and any additional rows or 
columns generated by the smoothing process.

Smoothing text box
First Impression uses the bi cubic B spline formula to determine how to smooth the chart data based 
on the smoothing factor you specify. Enter a valid factor from    0 - 32 

The following table describes valid smoothing factors:

Factor Description
 0 The raw grid data is used with no smoothing.

1 This factor samples the spline data only at the original data grid locations.

2-32 A factor of 2 or more will break the row and column locations into the specified number of subdivisions.

Use Separate Contour Data check box
A contour chart displays only contour data, but a surface chart can display both contouring and 
elevation data. Uncheck this checkbox to use all data in the data grid for both contouring and elevation.
Check this checkbox to provide separate contour and elevation data. When this checkbox is checked, 
the data grid is divided vertically between columns into two equal subranges of data. The left subrange 
contains elevation data, and the right subrange contains contouring data. 

When Use Separate Contour Data is enabled, a surface chart will display surface contours that do not 
necessarily conform to the shape of the surface. For example, a surface chart displaying separate 
contour and elevation data might depict snowfall across a mountain range.



Surface Color picker
Surface color applies to both surface and contour charts and controls the color used to draw solid chart
surfaces.



Wireframe Color picker
Wireframe color controls the color used to draw the wireframe for 3D surface charts.



Wireframe Width picker
Wireframe width controls the width of the line used to draw the wireframe for 3D surface charts.



Automatic Contouring Values check box
 Automatic values refers to the values used to display chart contours. Check this checkbox if you wish 
to have each major axis division represent a separate contour. Uncheck this checkbox if you want to 
design your own custom contours.



Contour Colors list box
The Colors option in the contouring tab controls how color is displayed on the chart. The following table
describes the valid color types:

Type Description
Automatic The contour colors are displayed as the default series colors.

Gradient The contours are displayed in an even transition of color. 

Manual Custom contour colors can be specified and modified by the user. (Manual colors is only available when 
Automatic values is unchecked.)

Contour Value List box
The values representing each contour are displayed here. Select a value from the list to modify, label 
or delete a contour.



New Contour button
Click this button to add a new contour value to the list.



Delete Contour button
Click this button to delete the selected contour value from the list



Contour Value text box
Enter a new contour value here.



Contour Label text box
Enter a new label for the selected contour value here.



Band Options list boxes
Style    Select a contour band style

Color    Select a contour band color



Line Options list boxes
Width    Select a contour line width.

Color    Select a contour line color.




